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“A união entre espaço natural e ações 

cumulativas feitas por gerações e 

gerações de humanos é chamada de 

espaço total. Para entender suas relações 

e a influência da implantação de novos 

planos e projetos é necessária a utilização 

de todos os dispositivos de medição de 

impactos físicos, ecológicos e sociais 

disponíveis. Ao mesmo tempo devemos 

combater os modelos predatórios de 

comportamento. Há que moderarmos e, 

sobretudo, sermos criativos, a fim de 

obtermos lucros sem destruirmos o capital 

ecológico e ambiental” 

                                                        AZIZ AB’SÁBER 



 
 

RESUMO 

 

 

Cada vez mais é importante o pensamento sobre a manutenção do equilíbrio entre o 

homem, o meio físico e as atividades no campo. Por isso, um dos principais desafios 

das geociências é o gerenciamento do uso e conservação do solo, não apenas como 

prática conservacionista, mas também como estratégia econômica podendo produzir 

mais sem causar danos ao meio ambiente. Neste sentido, o objetivo deste trabalho foi 

analisar a fragilidade potencial e ambiental multitemporal do município de Dois Irmãos 

do Buriti – MS. Para tanto, foram adquiridos dados geográficos de diversas fontes a 

fim de montar um banco de dados em ambiente SIG para possibilitar o trabalho 

utilizando o software ArcGis/ArcMap® e Spring. Para a análise da fragilidade potencial 

e ambiental de Dois Irmãos do Buriti, foram utilizadas técnicas de álgebra de mapas, 

análise multicritério baseada na metodologia proposta por Ross (1994), levando em 

conta as variáveis, solo, declividade, pluviosidade, áreas prioritárias para a 

conservação da biodiversidade e cobertura e uso da terra. Os resultados mostram que 

a fragilidade potencial do município de Dois Irmãos do Buriti constitui-se em sua 

maioria um nível de muito baixo a médio, totalizando 89,23% do território, possuindo 

uma declividade entre 0 e 6%. Foram mapeadas a fragilidade ambiental para os anos 

de 1998, 2008 e 2018, totalizando um período de 20 anos. A análise dos dados 

mostraram que embora o município tenha ficado com a maior parte das áreas entre 

as fragilidade muito baixa e médias, houve uma variação entre as classes, 

evidenciando o crescimento do cultivo de pastagens na região para a bovinocultura, 

porém, o município permaneceu com a fragilidade ambiental em sua maioria baixa e 

muito baixa durante o período analisado. O mapeamento e análise das erosões 

mostrou que a maior parte ocorre em locais com baixa fragilidade, evidenciando a falta 

de cuidados com o manejo e conservação dos recursos. 

Palavras chave: Geoprocessamento, Fragilidade Ambiental, Dois Irmãos do Buriti 

 

 

 

 



 
 

ABSTRACT 

It is becoming increasingly important the thought of maintaining the balance between 

man, environment and field activities, so one of the main challenges of geosciences is 

managing land use and conservation, not just as conservation practices, but as 

economic strategies too, thus production can be raised without harming the 

environment. Therefore, the objective of the study is to analyze the potential 

environmental and multitemporal fragility of the municipality of Dois Irmãos do Buriti - 

MS. Geographic data were acquired from various sources and assembled in a 

database in the SIG environment to enable work using ArcGis / ArcMap® and Spring 

software. For the analysis of the potential and environmental fragility of Dois Irmãos 

do Buriti, it was used map algebra techniques, multicriteria analysis applied to the 

methodology proposed by Ross (1994), considering variations, soil, slope, priority 

areas for biodiversity conservation and land use. The results show that the fragility 

potential of Dois Irmãos do Buriti is mostly very low to medium level. totaling 89.23% 

of the territory, with a slope between 0 and 6%. An environmental fragility of 3 years, 

1998, 2008 and 2018 was mapped, totaling a period of 20 years. The data analysis 

showed that although the county had the it most areas between the very low and 

medium fragility level, there was a variation between classes, showing the growth of 

pasture cultivation in the region for cattle. however, the municipality remained with the 

environmental fragility mostly low and very low during the analyzed period. The 

mapping and analysis of erosions showed that most of them occur in places with low 

fragility, showing the lack of care with the management and conservation of resources. 

 

Keywords: Geoprocessing, Environmental Fragility, Dois Irmãos do Buriti. 
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1.  INTRODUÇÃO 
 

 O Cerrado da região Centro-Oeste brasileira passou por um processo de 

antropização acelerada durante as últimas quatro décadas (HOGAN et. al., 2002). A 

região vem se firmando nas últimas décadas, como economia baseada 

predominantemente na pecuária extensiva de corte, na pecuária extensiva de leite, na 

agricultura extensiva de alimentos básicos, e, mais recentemente, na produção de 

milho e soja. Nesse sentido, o conhecimento e mapeamento das dinâmicas 

ambientais são tarefas cada vez mais importantes para os gestores, pois monitorar 

tais dinâmicas e entender suas influências pode ajudar a elaborar políticas públicas e 

estratégias para o melhor aproveitamento e proteção dos recursos, ou seja, para que 

tenhamos um desenvolvimento sustentável. 

Conforme Moysés e Silva (2008), o Cerrado está em uma posição estratégica 

no país, os autores citam algumas razões: por estar no centro do país, portanto perto 

dos grandes centros consumidores; por sua malha rodoviária que facilita o 

escoamento da produção; pelo desenvolvimento de cultivares adaptados ao solo e 

clima; por suas grandes extensões de planícies, propiciando assim o desenvolvimento 

da pecuária e da agricultura mecanizada. Sendo assim a região é uma grande 

produtora de commodities oriundos do agronegócio. 

Com o advento da necessidade de estudar e quantificar a relação entre as 

atividades antrópicas e a questão ambiental, surgiram diversos modelos para a 

avaliação de fragilidade potencial e ambiental, tais modelos permitem quantificar os 

graus de fragilidade dos ambientes e por sua vez avaliar  os produtos gerados com o 

intuito de subsidiar o poder público na tomada de decisões e no planejamento 

territorial, visando a adequação do uso e ocupação do solo e a minimização dos 

impactos ambientais (MANFRÉ et. al., 2013). 

Segundo Chagas (2011), mais de 80% do solo do município de Dois Irmãos do 

Buriti – MS é utilizado com pastagens e com agricultura, apenas 20% apresenta certo 

grau de preservação. 

Desse modo, embora existam vários estudos sobre a temática da fragilidade 

ambiental no país, bem como no estado de Mato Grosso do Sul, tal estudo se justifica, 

pois o município de Dois Irmãos do Buriti – MS não possui esse tipo de mapeamento 
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em nível municipal e de caráter multitemporal. Tendo em vista que o município possui 

diversas riquezas paisagísticas, como uma infinidade de cursos d’água, com destaque 

para os dois braços do Rio Dois Irmãos e o Rio Aquidauana nas proximidades do 

distrito de Palmeiras, e diversas limitações ambientais pelo seu uso diverso por 

assentamentos, aldeias e uso agrícola. 

Desde a década de 1970, imagens obtidas por meio de sensores remotos 

orbitais vêm sendo usadas para análise e mapeamento da cobertura da superfície 

terrestre. Com o lançamento do satélite Landsat em 1972 e reforçado com o 

lançamento do satélite Spot em 1986, o sensoriamento remoto passou a ser uma 

ferramenta importante no que tange a análise ambiental, tanto na escala local, 

regional e global (COUTINHO, 1997). Diversos estudos são realizados para aproveitar 

todo o potencial das técnicas de processamento digital em ambiente SIG para 

planejar, monitorar e mapear áreas urbanas e rurais. 

De acordo com Câmara; Monteiro; Medeiro (2004) no estudo de modificações 

no espaço geográfico, o sensoriamento remoto tem sido de grande auxílio. Os 

processos que ocorrem no espaço geográfico podem ser tratados e interpretados com 

o uso de técnicas matemáticas e computacionais, denominadas em seu conjunto 

como geoprocessamento. 

 Segundo Paranhos Filho et al. (2016) com o avanço do poder de 

processamento de dados dos computadores e com o advento de softwares livres e 

gratuitos, nota-se uma redução de custos na análise de imagens de satélite, imagens 

que, por sua vez, tiveram uma queda de custo e no caso de imagens Landsat o custo 

é zero. Deste modo, o uso das geotecnologias no mapeamento e análise da fragilidade 

potencial e fragilidade ambiental no município de Dois Irmãos do Buriti, vai possibilitar 

um estudo de caso com economia de tempo e a análise de uma grande área de 

interesse de forma multitemporal, bem como relacionar os resultados com a 

ocorrência de processos erosivos. 
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2. OBJETIVOS 

 

2.1 OBJETIVO GERAL 

 

 Caracterizar a fragilidade potencial e avaliar os efeitos da intensificação do uso 

da terra na fragilidade ambiental do município de Dois Irmãos do Buriti – MS por meio 

de técnicas de álgebras de mapas em ambientes SIG. 

 

2.2 OBJETIVOS ESPECÍFICOS 

 

 Identificar os diferentes níveis de fragilidade potencial; 

 Analisar as mudanças no uso e cobertura da terra; 

 Mapear a ocorrência de processos erosivos; 

 Compreender a relação da distribuição espacial dos processos erosivos com 

as fragilidades potencial e ambiental.   
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3. REFERENCIAL TEÓRICO-METODOLÓGICO 

 

3.1 GEOTECNOLOGIAS APLICADAS AO PLANEJAMENTO E GESTÃO 

AMBIENTAL 

 

 Rosa (2005) define o geoprocessamento ou geotecnologias como um conjunto 

de tecnologias para coleta, processamento, análise e oferta de informações com 

referência geográfica. Tecnologias essas que são compostas por um conjunto de 

soluções em hardware, software e peoplewere que juntos consistem em poderosas 

ferramentas para tomada de decisões. Bacani e Luchiari (2014) destacam que se trata 

de um termo muito empregado na Geografia e abrangente por envolver diversas áreas 

do conhecimento, como: sensoriamento remoto, cartografia digital, sistemas de 

informação geográfica, sistemas de posicionamento global via satélite, topografia, 

entre outras. 

 Outra importante definição de geoprocessamento é a de Rocha (2002), onde é 

descrito como uma tecnologia transdisciplinar que, integra várias disciplinas através 

do processamento de dados geográficos e a axiomática da localização. 

Equipamentos, programas, processos, entidades, dados, metodologias e pessoas 

para a coleta, tratamento, análise e apresentação de informações associadas a mapas 

digitais georreferenciados. Rocha (2002) afirma que não existe consenso na definição 

deste termo e vários conceitos são encontrados na bibliografia especializada. 

 O geoprocessamento está sendo amplamente difundido, graças ao 

desenvolvimento e aprimoramento dos softwares, tornando possível a apresentação 

de produtos confiáveis que podem ser utilizados em várias áreas do conhecimento. 

Pode ser destacado o monitoramento de fenômenos naturais ambientais (erosão de 

solo, inundações, deslizamentos, entre outros) e antrópicos (queimadas, 

desmatamentos, etc.) proporcionando a identificação destes fenômenos (OLIVEIRA, 

2009). 

 Conforme explica Couto (2007) as geotecnologias formam uma base adequada 

para o gerenciamento dos recursos naturais e para a análise do meio ambiente, tudo 

isso subsidiado pelo avanço em relação as técnicas convencionais de gerenciamento 
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e controle ambiental, principalmente no que se refere à integração de dados, e na sua 

capacidade de conjugar diversas tecnologias. 

 Neste sentido, Couto (2007) complementa que os Sistemas de Informações 

Geográficas são capazes de sobrepor diferentes tipos de mapas como, por exemplo, 

hidrografia, pedologia, pluviosidade, cobertura vegetal, geologia, entre outros, tais 

mapas são denominados como camadas, assim, pode-se obter um mapa síntese com 

a combinação de todos eles, sendo usados posteriormente para avaliação de riscos, 

pois as informações podem ser correlacionadas, proporcionando assim a mensuração 

das áreas de maior ou menor fragilidade ambiental, proporcionando a identificação 

das áreas de risco. 

 As Geotecnologias evoluíram rapidamente nas últimas décadas graças ao 

avanço técnico-científico-informacional, assim se tornou possível analisar o espaço 

geográfico de uma maneira mais rápida e mais eficiente. Nesse sentido Florenzano 

(2005) destaca o aumento das aplicações das geotecnologias em diferentes campos 

do conhecimento, pois as imagens obtidas através do sensoriamento remoto 

proporcionam uma visão multitemporal de áreas extensas. Os estudos regionais e 

integrados do ambiente e da paisagem são possibilitados por essa visão sinóptica, 

tais informações mostram as transformações dos ambientes, destacam os impactos 

causados por fenômenos naturais como as inundações e a erosão do solo (agravados 

pela intervenção do homem) e antrópicos, como os desmatamentos, as queimadas, a 

expansão urbana, ou outras alterações do uso e da ocupação da terra 

(FLORENZANO, 2002). 

 A Gestão Ambiental, de acordo com Barbieri (2004), são os procedimentos e 

atividades administrativas e operacionais realizadas com o objetivo de obter efeitos 

positivos sobre o meio ambiente, mitigando os efeitos causados pelas ações 

humanas, ou evitando que elas surjam. Diante disso, qualquer iniciativa de gestão 

ambiental envolve três dimensões: a espacial, que se refere a área ou região alvo da 

iniciativa; a dimensão temática, referente as questões ambientais às quais as ações 

se destinam; e a dimensão institucional, que se refere aos agentes que tornam as 

iniciativas de gestão ambiental. 
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3.2 SENSORIAMENTO REMOTO 

 

Segundo Paranhos Filho et al. (2016) Sensoriamento Remoto é a obtenção de 

dados ou informações de um objeto que está distante do sensor de amostragem. 

Essas imagens e dados são obtidas por meio de captação do registro de energia 

refletida pela superfície do objeto. Com as imagens obtidas com o conjunto de 

sensores embarcados em um satélite ou VANT (veículo aéreo não tripulado), 

podemos obter os dados e estudar as interações que ocorrem na superfície da Terra. 

Novo (2008) afirma que a partir do registro e da análise das interações entre a 

radiação eletromagnética e as substâncias que o compõem em suas mais diversas 

manifestações podemos estudar fenômenos da superfície do planeta. 

 De acordo Tostô et al. (2014) seriam considerados sensores remotos os 

sensores que operam com energia acústica (sonares, sismógrafos, sismômetros, 

etc.), com energia gravitacional (gravímetros) e com energia eletromagnética 

(radiômetros). Porém, o uso do termo ficou restrito aos equipamentos que operam 

apenas pela detecção da energia eletromagnética ou radiação eletromagnética. 

 Moraes (2002) ressalta as interações entre a quantidade de energia 

eletromagnética refletida pelos objetos em terra. Tais interações são determinadas 

pelas propriedades físico-químicas e biológicas dos objetos e podem ser identificadas 

nas imagens e nos dados e sensores remotos, sendo assim, a energia 

eletromagnética refletida e emitida pelos objetos terrestres é a base de dados para 

todo processo de sua identificação, pois ela permite quantificar a energia espectral 

refletida e analisar suas principais características. Por conseguinte os sensores 

remotos são indispensáveis para a realização de inventários, de mapeamento e de 

monitoramento de recursos naturais. 

 De acordo com Novo (2008), o sensoriamento remoto como sistema de 

aquisição de informações pode ser dividido em dois grandes subsistemas: subsistema 

de aquisição de dados de sensoriamento remoto e subsistema de produção de 

informações (Figura 1): 
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O Subsistema de Aquisição de Dados de Sensoriamento Remoto é 

formado pelos seguintes componentes: Fonte de Radiação, 

Plataforma (Satélite, Aeronave), Sensor, Centro de Dados (Estação 

de Recepção e Processamento de Dados de Satélite e Aeronave). O 

Subsistema de Produção de Informações é composto por: Sistema 

de Aquisição de Informações de Solo para Calibragem dos Dados de 

Sensoriamento Remoto; Sistema de Processamento de Imagens, 

Sistema de Geoprocessamento (NOVO, 2008, p. 33). 

 

 

Figura 1: Subsistemas que compõem o sistema de informações derivadas de 

sensoriamento remoto. 

 

Fonte: Novo (2008). 
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3.2.1. SEGMENTAÇÃO  

 

Conforme explica Paranhos Filho et al. (2016), a segmentação é um sistema 

que gera uma séria de polígonos, capaz de separar os objetos baseado em um 

algoritmo de similaridade, resultando numa imagem com divisões homogêneas, esse 

critério tem padrões de comparabilidade, suavidade e resposta espectral pré-definidos 

pelo usuário, além de escala de segmentação. A partir disso, é possível criar um 

sistema de hierarquia de objeto em conjunto com um sistema também hierárquico, 

mas de classes. 

 De acordo com Moreira (2005), a segmentação constitui-se como processo de 

formação dos objetos em uma imagem, e é a primeira etapa da classificação, a qual 

consiste em dividir ou mesmo segmentar a imagem em regiões homogêneas com o 

intuito de eliminar problemas de subjetividade em classificações supervisionadas. 

Esse processo pode ser elaborado em diversos softwares, entre os mais difundidos 

está o eCognition (DEFINIENS, 2001), e consiste em associação de formas com 

características semelhantes, como textura, forma e áreas com parâmetros espectrais. 

 O nível de detalhe em que a subdivisão é realizada depende da demanda do 

estudo a ser realizado, em outras palavras, a segmentação obteve êxito quando os 

objetos ou as regiões de interesse forem detectadas. É importante atentar para a 

precisão na aplicação da técnica de segmentação, pois a precisão pode determinar o 

sucesso ou fracasso final dos procedimentos em análise. Por esse motivo, é de 

extrema importância o cuidado para aumentar a probabilidade de se obter uma 

segmentação precisa (GONZALEZ e WOODS, 2010). 

 É possível observar na ilustração elaborada por Correia et al. (2007) a diferença 

da segmentação com parâmetros diferentes (Figura 2): 
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Figura 2 – Segmentação sobreposta à imagem 

 

Fonte: Correia et al. (2007). 

 

3.3 SISTEMA DE INFORMAÇÃO GEOGRÁFICA (SIG) 

 

Conforme afirma Fuenzalida et al. (2015) os SIGs sintetizam uma longa 

evolução do pensamento teórico-metodológico da Geografia como ciência. Os 

métodos de análise numérica e cartográfica, que durante séculos foram realizados de 

forma análoga, desde meados do século XX que entraram no formato digital em 

computadores para tratamento e análise. 

 Para Rosa (2005), SIG ou GIS (do inglês Geographic Information System) é: 
  

Um conjunto de ferramentas computacionais composto de 

equipamentos e programas que, por meio de técnicas, integra dados, 

pessoas e instituições, de forma a tornar possível a coleta, o 

armazenamento, o processamento, a análise e a oferta de 

informação georeferenciada produzida por meio de aplicações 

disponíveis, que visam maior facilidade, segurança e agilidade nas 

atividades humanas referentes ao monitoramento, planejamento e 

tomada de decisão relativas ao espaço geográfico (ROSA, 2005, 

p.81). 
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 O ambiente SIG é o ideal para integrar dados, informações e cartas de 

naturezas e escalas diferentes, Por exemplo, dados climáticos e cartas topográficas 

ou de solos podem ser analisadas em conjunto, levando toda informação para uma 

base comum, o que permite a sua integração e uso (PARANHOS FILHO et al., 2016).  

 Assim, de acordo com Paranhos Filho et al. (2016) o geoprocessamento 

permite que se calcule o valor da erosão laminar dos solos em uma determinada área. 

Ou ainda, integrando-se dados socioeconômicos e distribuição da população, 

podemos analisar a inclusão e exclusão social. 

 De acordo com Rosa (2013) o objetivo geral do SIG, é, contudo, servir de 

instrumento eficiente para diversas áreas do conhecimento que fazem uso de mapas, 

possibilitando: (I) integrar em uma única base de dados informações representando 

vários aspectos do estudo de uma região; (II) permitir a entrada de dados de diversas 

formas; (III) combinar dados de diferentes fontes, gerando novos tipos de informações; 

(IV) gerar relatórios e documentos gráficos, entre outros. É possível também em 

ambiente SIG fazer modelagens ambientais, aplicar técnicas de álgebra de mapas, 

analisar uma enorme quantidade de dados e manter e disponibilizar os mesmos em 

um único banco de dados. 

 Bacani (2010) adverte que embora tenham surgido produtos com avanços 

tecnológicos no mercado, a custos baixos, apresentando fácil manuseio e segurança 

para o usuário, é válido ressaltar que a utilização dos SIGs não garante a certeza e a 

segurança do produto final. Nesse caso, é importante que se tenha um rigoroso 

controle de qualidade do banco de dados, que armazenem uma base de informações 

alfanuméricas, raster e/ou vetoriais. 

 De modo geral, podemos sintetizar quem um SIG tem os seguintes 

componentes, conforme ilustrado abaixo (Figura 3): 
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Figura 3 - Estrutura interna de um SIG 

 

Fonte: CÂMARA; MONTEIRO; MEDEIRO (2004). 
 

3.4 ANÁLISE DE FRAGILIDADE AMBIENTAL NA ESCALA MUNICIPAL  

 

O geógrafo Milton Santos em seu livro “A natureza do espaço” diz que o espaço 

é um conjunto indissociável de sistemas objetos e sistemas ações, (SANTOS, 2004) 

deste modo, ao viver produzimos o espaço geográfico, espaço esse que é dinâmico. 

Não produzimos só o espaço urbano, mas também interferimos no campo para a 

nossa subsistência. 

Cada vez mais o ser humano intervém no meio natural, o desenvolvimento 

técnico-científico-informacional propiciou uma intervenção mais acelerada nos últimos 

anos, Ross (1994) destaca que, a princípio, salvo algumas regiões do planeta, os 

ambientes naturais mostram-se ou mostravam-se em estado de equilíbrio dinâmico 

até o momento em que a sociedade humana passou a intervir cada vez mais 

intensamente na exploração de recursos naturais. 

Para entendermos o conceito de Fragilidade ambiental, podemos recorrer a 

Teoria dos Sistemas. Conforme explica Vitte e Santos (1999) um sistema se define 

como um complexo de elementos em interação, interação essa de natureza ordenada. 
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Desse modo, de acordo com a dinâmica dos sistemas ambientais, é possível mapear 

e quantificar suas fragilidades potenciais e ambientais. 

Podemos conceituar dois tipos de fragilidade ambiental diferentes, de acordo 

com Kawakubo et al. (2005) existe a fragilidade  chamada potencial – caracterizada 

pela fragilidade natural que uma determinada área está submetida, ou seja, a partir 

do tipo de solo, declividade do relevo, erosividade, erodibilidade, entre outros, onde o 

local poderá ou não apresentar um equilíbrio natural e a fragilidade emergente (ou 

ambiental) que, além de considerar os elementos naturais observáveis na fragilidade 

potencial, acrescenta o fator humano, que se caracteriza pelo uso da terra. 

Para estudar a relação entre a sociedade e natureza, podemos utilizar as 

propostas de Ross (1994; 2012), onde preconizou-se uma metodologia empírica da 

fragilidade ambiental. Metodologia esta que foi desenvolvida tanto para analisar 

ambientes naturais quanto ambientes sob a ação antrópica.  

As avaliações são realizadas integrando em ambiente SIG os setores do estrato 

geográfico (solos, relevo, rochas, clima, flora, fauna, entre outros) que dão suporte à 

vida animal e humana. O objetivo da metodologia é avaliar o conjunto de fatores 

ambientais e a intervenção humana, para isso, é necessário o conhecimento das 

potencialidades dos recursos naturais, que se relacionam com as condições gerais do 

solo, relevo, clima e regime hídrico (SOARES, 2008). 

 A metodologia desenvolvida por Ross (1994) conseguiu sanar uma questão 

levantada por Tricart (1977): 

Do ponto de vista quantitativo, apoiamo-nos no balanço 
pedogênese/morfogênese. Desde que a instabilidade é fraca, a 
pedogênese ganha vantagem com toda uma série de termos de 
transição para os meios estáveis. Como em mecânica do solo, a 
distinção entre meios estáveis e meios intergrades só poderia ser 
convencional, porém isto exigiria critérios numéricos que ainda estão 
por definir. Ainda não se pode saber se isto será possível. Aqui, 
também, a transição é contínua e os problemas aparecem. 
(TRICART, 1977, p. 48) 

 Podemos encontrar diversos estudos utilizando as metodologias de fragilidade 

ambiental, subsidiando o planejamento territorial e auxiliando o poder público na 

tomada de decisões. Ao comparar os modelos de Ross (1994) e Crepani et al. (2001) 

utilizados nas bacias hidrográficas do rio Jaguari-Mirim e dos ribeirões Quartel e Prata, 

Spörl (2001), por meio de comparação de mapeamentos distintos, utilizando as 
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operações propostas nos dois modelos, concluiu que o modelo de Ross (1994) seria 

mais bem sucedido, pois o modelo de Crepani et al. (2001), por considerar a média 

aritmética dos graus de fragilidade entre as variáveis, pode apresentar resultados de 

fragilidade atenuados quando comparados ao modelo de Ross (1994), pois esse 

último, realiza um agrupamento das variáveis. Spörl (2001) explica que pela 

metodologia de Crepani et al. (2001) uma localidade com rochas resistentes 

associadas ao relevo dissecado e solo com alta vulnerabilidade à erosão pode 

apresentar, pela média de variáveis, resultados de graus de fragilidade semelhantes 

a uma área de rochas frágeis em relevo plano. Porém, a possibilidade da utilização 

dos dois modelos não foi excluída, ambas podem ser utilizadas para fins de 

planejamento e gestão territorial. 

 Diversos estudos têm sido desenvolvidos no que se refere ao tema fragilidade 

ambiental em nível municipal. Santos et al. (2010) analisaram a fragilidade ambiental 

do município de Tamboara – PR. Por meio da metodologia de Ross (1994) foram 

geradas as cartas de fragilidade potencial e fragilidade emergente para o estudo da 

área. Foi constatado no vale do Ribeirão Suruquá, a fragilidade potencial mais alta no 

município, em contrapartida a fragilidade emergente foi amenizada de certo modo, 

pois o solo é ocupado por pastagem em sua maior parte. Observou-se também, que 

a região do ribeirão Anhamuí, onde identificou-se baixo grau de fragilidade potencial, 

composta por Argissolos, constatou-se uma fragilidade emergente maior, pois o uso 

do solo é basicamente de cana de açúcar. 

 Trevisan e Moschini (2016) determinaram as áreas de fragilidade ambiental do 

município de São Carlos, localizado na região central do estado de São Paulo (ICG, 

2015) utilizando técnicas de geoprocessamento e a metodologia qualitativa, com 

procedimento empírico, desenvolvida por Ross (1994). Como resultado, foi obtido o 

mapa de fragilidade ambiental, onde foi observado que o forte processo de 

antropização gerou problemas conservacionistas, causando uma influência direta no 

grau de fragilidade ambiental. Cerca de 89% da área de estudo foi associada a um 

grau de fragilidade ambiental média a muito alta, destacando nesses locais Neossolos 

Quartzarênicos e Nitossolos Vermelhos, somada a declividades que ultrapassam os 

30%. Determinou-se cerca de 10,61% da área com um grau de fragilidade baixa e 

muito baixa, essas regiões apresentam vegetação nativa, incluindo Áreas de 
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Preservação Permanente, possuírem declividades que não ultrapassam 20% e serem 

formadas por Latossolo Vermelho. 

 Em sua dissertação de mestrado, Bueno (2015) pode avaliar e representar 

cartograficamente as áreas suscetíveis à degradação, conforme os graus de 

suscetibilidade as classes atribuídas por meio de informações naturais (geologia, 

relevo, solos) e antrópicas (uso e ocupação do solo) do Município de Guaíra-PR. Com 

a carta de fragilidade emergente em mãos, foi possível reconhecer que 70% do 

município foi classificado com o nível de fragilidade médio, tal índice se deve ao nível 

de fragilidade potencial somado com o uso do solo do município, que em sua maior 

parte é composta por culturas temporárias. 

 Terra et al. (2016) utilizando técnicas de álgebras de mapas em ambiente SIG, 

caracterizou a fragilidade ambiental do município de Santiago - RS. Para a 

determinação das classes hierárquicas e atribuições de pesos as mesmas, foi utilizada 

a metodologia proposta por Ross (1994), onde foi sistematizado os atributos de peso 

às fragilidades representadas por códigos específicos: (1) muito fraca, (2) fraca, (3) 

média, (4) forte e (5) muito forte. A maior classe do município de Santiago – RS foi 

classificada com a fragilidade média, 815,6 km², aproximadamente 34% do território. 

A segunda maior classe foi a de fragilidade muito alta, com 29,3%, esta última classe 

está ligada com a presença de solo exposto, agricultura e áreas urbanas. Com isso 

os autores ressaltaram a necessidade de um cuidado especial com as áreas e a 

importância dos planos urbanos de uso e ocupação do solo. 

 Pires, Mendonça e Bacani (2015) realizaram uma análise da fragilidade 

ambiental do município de Aquidauana – MS, com o uso das geotecnologias. Como o 

município tem uma grande influência da presença do bioma Pantanal, que abriga uma 

grande biodiversidade, foi adicionada nesse trabalho uma nova variável: as áreas 

prioritárias para a conservação da biodiversidade, além das variáveis 

geomorfológicas, pedológicas e de cobertura do solo da metodologia proposta por 

Ross (1994). Após a elaboração do mapa de fragilidade potencial foi possível 

acrescentar no cálculo de álgebra de mapas a variável de uso e cobertura da terra, 

chegando assim ao mapa de fragilidade ambiental. A fragilidade muito baixa foi a 

menor porcentagem encontrada no município, com 0,34%. 4,15% do município foi 

classificado com a fragilidade baixa, são regiões com pastagens e vegetação arbórea, 

com baixas até altas declividades. A maior classe foi atribuída a fragilidade média, 
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com 46,88% do município, são ocupadas com áreas de pastagens e vegetação 

arbórea, relacionadas principalmente a Planossolos. A alta fragilidade teve a terceira 

maior distribuição, com 23,65% e a muito alta, segunda maior, com 24,94%. 

 Leite e Rodrigues (2018) mapearam a fragilidade ambiental do município de 

Anastácio – MS, por meio das metodologias desenvolvidas por Ross (1994), Crepani 

et. al., (2001) e Carvalho (2008). Depois de realizar a álgebra de mapas unindo as 

variáveis de solo, geologia, declividade e cobertura vegetal; foi gerada a carta de 

fragilidade ambiental, onde foram classificados como muito baixa 1,37 da área do 

município, como baixa 27,4%, média 67,27%, alta 3,96% e muito alta 0%. Tal trabalho 

mostrou que o município está inserido em uma zona de fragilidade natural elevada, 

com alta capacidade erosiva provocada pela chuva, declividade acentuada, devido a 

presença da Serra de Maracaju e solos Neossolos que tem uma alta susceptibilidade 

à erosão, tais variáveis somadas ao uso antrópico, tornam o município de Anastácio 

– MS susceptível a degradação ambiental. Sendo assim os autores indicaram maior 

atenção em relação às áreas de preservação permanente. 
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4 PROCEDIMENTOS METODOLÓGICOS  

 

 Para realizar a análise da fragilidade potencial e ambiental em ambiente SIG 

do município de Dois Irmãos do Buriti - MS foi realizada inicialmente uma revisão 

bibliográfica sobre a metodologia proposta por Ross (1994 e 2012), bem como o 

estudo e emprego de técnicas de geoprocessamento para se obter os mapas e 

realizar a interpolação e análise dos dados. Para melhor ilustrar os caminhos 

percorridos para chegar aos resultados, o fluxograma da Figura 4 facilita a 

visualização e o entendimento da metodologia utilizada. 
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Figura 4 – Fluxograma com os procedimentos metodológicos adotados.

 

Fonte: Silva, A. A. M. (2019) 
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4.1 Localização da área de estudo 

 

 O município de Dois Irmãos do Buriti tem uma área de aproximadamente 2.345 

km². Está localizado na região geográfica intermediária de Campo Grande no Estado 

de Mato Grosso do Sul (IBGE, 2017), no retângulo envolvente das Latitudes 

20°8'23.59"S/ 21°2'35.14"S e longitudes 55°35'12.43"O/ 55°09'7.21"O (Figura 5). Faz 

divisa com os municípios de Aquidauana ao norte, ao sul com o município de 

Sidrolândia, e leste com o município de Terenos e com o município de Anastácio a 

oeste. O município pertence à bacia hidrográfica do Rio Miranda. 

 O Município de Dois Irmãos do Buriti, em Mato Grosso do Sul, foi criado 

inicialmente como um distrito em 1976, era subordinado ao município de Anastácio. 

Foi elevado à categoria de município em 1987 pelo então governador do estado 

Marcelo Miranda Soares. Dois Irmãos do Buriti, possui um distrito denominado 

Palmeiras, pertencente à comarca de Aquidauana (IBGE, 2017). 

 Segundo os dados do Censo demográfico (IBGE, 2010), o município possuia 

uma população, no último censo, de 10.363 habitantes, já a estimativa para o ano de 

2019 é de um total de 11.385 habitantes, um aumento de 9.86% em 9 anos, com uma 

densidade demográfica de 4,42 hab/km². As atividades econômicas estão ligadas ao 

agronegócio e concentradas na pecuária (IBGE, 2010). 
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Figura 5: Mapa de Localização do município de Dois Irmãos do Buriti – MS. 
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4.1.1 Terras Indígenas 

 O município de Dois Irmãos do Buriti – MS, possui uma área de terra indígena 

demarcada pela FUNAI (Figura 06), a terra demarcada se localiza a sudoeste do 

município e possui sete aldeias dividindo o mesmo território, são elas Água Azul, 

Barreirinho, Buriti, Nova Buriti, Olho D’Água, Oliveira e Recanto. Todas as aldeias são 

da etnia Terena, segunda maior etnia de Mato Grosso do Sul (OLIVEIRA, 2011). 

 Em seu trabalho de conclusão de curso, Fonseca (2017), destaca os principais 

processos de ocupação dos Terenas na Terra Indígena Buriti, o primeiro destaque é 

o conflito armado da Tríplice Aliança contra o Paraguai de 1864 a 1870, que causou 

o primeiro processo de territorialização dos Terenas no local. No período da Guerra 

os indígenas que ocupavam o Mato Grosso do Sul, antigo Mato Grosso, foram 

dispersados pelas tropas paraguaias, sendo uma das principais rotas de fuga a Serra 

de Maracaju. Outro destaque é para as políticas oficiais de aldeamento do Serviço de 

Proteção ao Índio – SPI, entre os anos de 1920 e 1930. Por fim, Fonseca (2017) 

aponta o processo é a atual de busca por ampliação dos limites do território. 
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Figura 06 - Terras indígenas no município de Dois Irmãos do Buriti – MS. 
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4.1.2 Assentamentos Rurais 

 A movimento de reforma agrária pode ser entendido como um movimento que 

visa proporcionar a redistribuição das propriedades rurais, em outras palavras, 

objetiva a partilha da terra para que ela cumpra s sua função social. Segundo Oliveira 

(2007), os assentamentos rurais se originam de um conjunto de ações 

governamentais que orienta a redistribuição da estrutura fundiária de uma certa 

região. 

 Existem quatro assentamentos rurais no município de Dois Irmãos do Buriti – 

MS, Assentamento Marcos Freire, no limite com o município de Anastácio – MS; Santa 

Amélia, Paulo Freire e Piúva 5, sendo que os três últimos citados ficam próximos a 

área urbana do município. 

 Na figura 7 é possível observar a localização dos assentamentos rurais do 

município. 
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Figura 07 – Assentamentos Rurais do município de Dois Irmãos do Buriti – MS. 
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4.2 Solos do Município de Dois Irmãos do Buriti – MS 

O mapa de solos de Mato Grosso do Sul foi obtido no formato shapefile através 

do site do SISLA – Sistema Interativo de Suporte ao Licenciamento Ambiental, site 

esse que é mantido pelo IMASUL – Instituto de Meio Ambiente de Mato Grosso do 

Sul. Para recortar a área de interesse, foi utilizado o limite do município de Dois Irmãos 

do Buriti (IBGE, 2017). O mapa de solos foi baseado no Macrozoneamento 

Geoambiental (1989). A classificação dos solos foi feita de acordo com o Sistema 

Brasileiro de Classificação de Solos (SiBCS) – Embrapa (2018), pois a classificação 

obtida no arquivo estava defasada, é possível observar no Quadro 1 a comparação 

aproximada entre as classes anteriormente utilizadas e o SiBCS (2018). 

 A Figura 8 indica a distribuição espacial das principais classes de solo do 

município de Dois Irmãos do Buriti. 
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Figura 8: Mapa de Solos do Município de Dois Irmãos do Buriti – MS. 
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  Foram identificados 18 Classes de solos diferentes em Dois Irmãos do 

Buriti, tais classes estão especificadas no Quadro 1. 

Quadro 1 – Equivalências Aproximadas das nomenclaturas dos solos de Dois Irmãos 

do Buriti – MS, de acordo com EMBRAPA (3ª Aproximação – 1988, EMBRAPA (2018). 

BRASIL 
(EMBRAPA, 
1988 – 3ª 
aproximação) 

Classificação Anteriormente Usada na 
Embrapa Solos 

SiBCS (2018) 

Re4 Solos Litólicos eutróficos A moderado e 
chernozêmico textura argilosa 
cascalhenta e média cascalhenta 
relevo ondulado e forte ondulado + 
Latossolo Roxo eutrófico pouco 
profundo A moderado textura argilosa 
relevo ondulado 

Neossolos Litólicos 
eutróficos 

Re1 Solos Litólicos eutróficos e distróficos A 
moderado e chernozêmico textura 
argilosa cascalhenta e média 
cascalhenta relevo forte ondulado e 
ondulado + Podzólico Vermelho-
Escuro eutrófico Tb A moderado 
textura média/argilosa relevo ondulado 
+ Afloramentos Rochosos + Terra Roxa 
Estruturada eutrófica A chernozêmico 
textura argilosa não pedregoso e 
pedregoso relevo forte ondulado 

Neossolos Litólicos 
eutróficos 

Rd4 Solos Litólicos distróficos A moderado 
textura média pouco cascalhenta fase 
epipedregosa + Cambissolo distrófico 
Tb A moderado textura média pouco 
cascalhenta relevo suave ondulado e 
ondulado 

Neossolos Litólicos 
distróficos 

Ra2 Solos Litólicos álicos A moderado 
textura média muito cascalhenta relevo 
forte ondulado + Cambissolo distrófico 
Tb A moderado textura média 
cascalhenta relevo ondulado e forte 
ondulado + Podzólico Vermelho-
Amarelo distrófico Tb raso A moderado 
textura média cascalhenta/argilosa 
cascalhenta e média/argilosa relevo 
ondulado 

Neossolos Litólicos 
distróficos 

PVd5 Podzólico Vermelho-Amarelo distrófico 
Tb A moderado textura argilosa relevo 
ondulado + Podzólico Vermelho-
Amarelo distrófico Tb A moderado 
textura argilosa cascalhenta relevo 
suave ondulado + Solos Litólicos 

Argissolos Vermelho-
Amarelo 
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distróficos A moderado textura argilosa 
relevo ondulado 

PVd4 Podzólico Vermelho-Amarelo distrófico 
Tb A moderado textura argilosa + 
Latossolo Vermelho-Escuro distrófico A 
moderado textura argilosa relevo plano 

Argissolos Vermelho-
Amarelo 

PVd3 Podzólico Vermelho-Amarelo distrófico 
e álico Tb abrupto A moderado textura 
arenosa/média + Podzólico Vermelho-
Amarelo distrófico e álico Tb plíntico A 
moderado textura arenosa/média + 
Areias Quartzosas distróficas A 
moderado relevo plano 

Argissolos Vermelho-
Amarelo 

PVa10 Podzólico Vermelho-Amarelo álico Tb 
A moderado textura arenosa/média 
relevo plano e suave ondulado + 
Latossolo Vermelho-Amarelo álico A 
moderado textura média + Areias 
Quartzosas álicas A moderado relevo 
suave ondulado 

Argissolos Vermelho-
Amerelo 

LRe3 Latossolo Roxo eutrófico A moderado 
textura argilosa relevo suave ondulado 
+ Latossolo Roxo distrófico A 
moderado textura argilosa relevo plano 
e suave ondulado + Terra Roxa 
Estruturada eutrófica latossólica A 
moderado textura argilosa relevo suave 
ondulado 

Latossolo Vermelho 
eutroférrico 

LRd2 Latossolo Roxo distrófico A moderado 
textura argilosa + Terra Roxa 
Estruturada eutrófica A moderado 
textura muito argilosa relevo suave 
ondulado e plano 

Latossolo Vermelho 
distroférrico 

LRa1 Latossolo Roxo álico A moderado 
textura muito argilosa relevo plano 

Latossolo Vermelho 
aluminoférrico 

LEa19 Latossolo Vermelho-Escuro álico A 
moderado textura média relevo plano e 
suave ondulado + Latossolo Vermelho-
Escuro álico A moderado textura 
argilosa relevo plano 

Latossolo Vermelho 
aluminoférrico 

LEa11 Latossolo Vermelho-Escuro álico A 
moderado textura média relevo plano e 
suave ondulado + Latossolo Vermelho-
Escuro álico A moderado textura 
argilosa relevo plano 

Latossolo Vermelho 
aluminoférrico 

HGPd6 Glei Pouco Húmico Distrófico Ta e Tb, 
textura média, fase floresta tropical 
perenifólica de várzea, relevo plano + 
Cambissolo Distrófico Ta e Tb gleico A 
moderado, textura média, fase floresta 

Gleissolo Háplico 
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tropical perenifólia, relevo praticamente 
plano e suave ondulado 

AQa7 Areias Quartzosas álicas A moderado 
relevo plano e suave ondulado + 
Podzólico Vermelho-Amarelo álico Tb 
A moderado textura arenosa/média 
relevo suave ondulado + Latossolo 
Vermelho-Escuro álico A moderado 
textura média relevo plano 

Neossolo Quartzarênico 
Órtico 

AQa6 Areias Quartzosas álicas A moderado + 
Latossolo Vermelho-Amarelo distrófico 
A moderado textura média + Latossolo 
Vermelho-Escuro distrófico A 
moderado textura argilosa e média 
relevo plano e suave ondulado 

Neossolo Quartzarênico 
Órtico 

AQa12 Areias Quartzosas álicas A moderado + 
Podzólico Vermelho-Amarelo álico Tb 
A moderado textura arenosa/média 
relevo suave ondulado e plano 

Neossolo Quartzarênico 
Órtico 

AQa11 Areias Quartzosas álicas A moderado + 
Latossolo Vermelho-Escuro álico A 
moderado textura média relevo suave 
ondulado e plano 

Neossolo Quartzarênico 
Órtico 

Fonte: Macrozoneamento Geoambiental realizado no Estado de Mato Grosso do Sul 

(1989)/ Sistema Brasileiro de Classificação de Solos - Embrapa (2018). Organizado 

pelo autor. 

 

 O próximo passo foi a conversão do mapa de solos do formato vetorial para o 

formato raster, para tornar possível a atribuição de pesos para as classes de solos 

conforme a metodologia proposta por Ross (1994), para isso foi utilizado o Software 

ArcGis/ArcMap® 10.5(ESRI, 2018) Foram utilizadas as ferramentas: 

Arctoolbox>Conversion Tools>To Raster>Polygon to Raster. 

 Com o arquivo no formato raster foi possível utilizar a ferramenta Reclacify para 

reclassificar a imagem atribuindo a ela os valores com os pesos referente a fragilidade 

do solo, assim, foi obtida o mapa de fragilidade do solo do município (Figura 9). 
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Figura 9 – Mapa de Fragilidade do Solo do Município de Dois Irmãos do Buriti – MS. 
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Na Tabela 1 é possível observar como os solos foram agrupados em classes e 

nível de fragilidade referente ao peso que elas receberam. 

Tabela 1 – Agrupamento de Solos por Nível de Fragilidade. 

Classes de solo Nível de 
fragilidade 

Peso 

LEa11/LEa19/LRe3/LRd2/LRa1 Muito baixa 1 

PVd3/PVa10 Média 3 

PVd5/PVd4 Alta 4 

Ra2/AQa7/Rd4/AQa11/AQa6/HGPd6/AQa12/Re4/Re1 Muito Alta 5 

Fonte: Adaptado de Ross (1994). 

 

4.3 DECLIVIDADE DO MUNICÍPIO DE DOIS IRMÃOS DO BURITI – MS 

 

 O mapa de declividade do Município de Dois Irmãos do Buriti foi obtido através 

do mosaico de duas imagens do RADAR SRTM (TOPODATA/INPE). Após construção 

do mosaico em ambiente SIG, o Modelo Digital de Elevação (MDE) foi recortado 

conforme a área de interesse (Figura 10), em seguida foi utilizada a ferramenta Slope 

no software ArcGis 10.5 (ESRI, 2018) para a obtenção da declividade em 

porcentagem: Spatial Analyst Tools>Surface>Slope. Após a obtenção do MDE SRTM 

em porcentagem foi possível fazer a reclassificação do mesmo de acordo com as 

classes de declividade propostas pela metodologia de Ross (1994), para isso foi 

utilizada a ferramenta Reclassify do ArcGis 10.5: Spatial Analyst 

Tools>Reclass>Reclassify (figura 11). A Tabela 2 como foram definidas as classes de 

fragilidade em função da declividade (ROSS, 1994). 

Tabela 2 – Divisão das classes de fragilidade da declividade. 

Categorias Hierárquicas Classes 

1 – Muito Baixa >6% 

2 – Baixa De 6% a 12% 

3 – Média De 12% a 20% 

4 – Alta De 20% a 30% 

5 – Muito Alta >30% 

Fonte: ROSS (1994). 
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Figura 10 – Mapa de Altimetria do Município de Dois Irmãos do Buriti. 
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Figura 11 – Mapa da Declividade do Município de Dois Irmãos do Buriti – MS em 

porcentagem baseado em Ross (1994). 

 



46 
 

4.4 ÁREAS PRORITÁRIAS PARA A PRESERVAÇÃO DA BIODIVERSIDADE DE 

DOIS IRMÃOS DO BURITI – MS 

 Para obter o mapa das Áreas Prioritárias para a conservação da 

Biodiversidade, primeiramente foi incluído no ArcGis/Arcmap o Shapefile do 

levantamento das mesmas disponibilizado pelo Ministério do Meio Ambiente – MMA, 

aprovada pela deliberação CONABIO nº 39, de 14 de dezembro de 2005 (BRASIL, 

2005), que por sua vez foi baseada no Mapa de Biomas do Brasil elaborado pelo 

Instituto Brasileiro de Geografia e Estatística (IBGE, 2004) utilizando uma abordagem 

que visa a objetividade e eficiência; criando memória do processo de identificação de 

prioridades; gerando informações que possibilitam decisão informada. 

 Após a inclusão do shapefile em ambiente SIG, foi utilizado o limite do Município 

de Dois Irmãos Do Buriti – MS como máscara para realizar o recorte da área de 

interesse. A seguir o mapa de Áreas Prioritárias foi convertido no formato Raster para 

que pudesse ser reclassificado com o peso de importância biológica conforme a 

metodologia proposta por Ross (1994), (Tabela 3). O mapa das Áreas Prioritárias Para 

a Conservação da Biodiversidade pode ser visto na Figura 13. 

Tabela 3 – Áreas prioritárias para a conservação. 

Importância Biológica Níveis de Fragilidade Peso 

Não Prioritária Muito Baixa 1 
Alta Alta 4 
Extremamente alta Muito Alta 5 
Alta Muito Alta 5 

Fonte: Probio/MMA (2007) apud Félix da Silva e Bacani (2017) – Adaptado de Ross 

(1994). 

 

 A figura 12 ilustra as categorias nas áreas prioritárias, sendo que a figura 12 

(A) é uma imagem de criação de bovinos no Assentamento Piúva V, demonstrando a 

categoria não prioritária; a figura 12 (B) é uma imagem da Aldeia Buriti, que demonstra 

a categoria Alta; e por fim, a figura 12 (C) é uma imagem de uma queda d’água do rio 

Dois Irmãos, retirada na Fazenda Cachoeira, parte sul do município, ilustrando a 

categoria Muito Alta. 
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Figura 12 – Classes das Áreas Prioritárias para a conservação da Biodiversidade de 

Dois Irmãos do Buriti – MS. Não Prioritária (A), Alta Prioridade (B) e Muito Alta 

Prioridade (C). 

 

 

Fonte: Silva A. A. M. (2019), Silva K. A. (2019). 
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Figura 13 – Mapa das Áreas Prioritárias para a Preservação da Biodiversidade 

do Município de Dois Irmãos do Buriti – MS. 
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4.5 – PLUVIOSIDADE DO MUNICÍPIO DE DOIS IRMÃOS DO BURITI – MS 

 

 Para a elaboração do mapa pluviométricos, foram adquiridos os dados 

pluviométricos entre 1977 e 2006 de 9 estações meteorológicas, extraídos da Agência 

Nacional de Águas (ANA, 2018), disponibilizados em sua homepage, a localização e 

nome das estações estão descritas na Tabela 4. 

   

Tabela 4 – Localização das estações pluviométricas. 

  Estação Localização 

Nioaque  55°49'30,309"W, 21°9'20,693"S 
Maracaju 55°8'10,204"W, 21°37'3,731"S 
Bonito 56°30'58,611"W, 21°6'54,148"S 
Jardim 56°5'6,21"W, 21°27'2,822"S 
Estrada MT 56°5'21,364"W, 20°45'44,505"S 
Fazenda Lajeado 55°26'40,993"W, 20°17'27,818"S 
Sidrolândia 54°58'53,598"W, 20°57'49,695"S 
Vau do Bálsamo 54°30'28,555"W, 20°59'36,138"S 
Capão Bonito  54°45'52,905"W, 21°10'34,088"S 

Fonte: ANA (2018).  

 Para a classificação dos valores do peso da média pluviométrica exercida sobre 

a fragilidade potencial da área analisada, foi utilizada a metodologia proposta por 

Crepani et al. (2001) adaptada posteriormente para a de Ross (1994). Para isso foi 

usada uma técnica de interpolação IDW (Inverse Distance Weigted), que calcula os 

valores pelo inverso do quadrado das distâncias, ou seja, o interpolador assume que 

as feições mais próximas têm valores mais semelhantes que as mais separadas 

(BURROUCH; McDONNELL, 1998). 

 Após a obtenção da interpolação dos dados pluviométricos das 9 estações, 

obteve-se a precipitação média anual (PMA) que oscilou para área entre 1.215 mm e 

1.353 mm, considerando que a região em análise tem a duração do período chuvoso 

(DPC) de nove meses por ano. Assim, através da precipitação média anual (PMA) e 

da duração do período chuvoso (DPC) foi possível obter a intensidade pluviométrica 

(IP), PMA/DPC = IP (CREPANI et al., 2001). 

 A seguir, foi feita uma adaptação do valor obtido pela metodologia de Crepani 

et al. (2001), que tem um valor máximo de 3, para a proposta por Ross (1994) que 

tem um valor máximo de 5, por meio de uma regra de 3 simples. 
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Tabela 5 – Escalas de Vulnerabilidade/fragilidade. 

Metodologia Crepani et. al (2001) Ross (1994) 

Peso 
3 5 

1,5 2,5 

Fonte: Adaptado de Crepani et al (2001) e Ross (1994).  

 

4.6 – USO DA TERRA NO MUNICÍPIO DE DOIS IRMÃOS DO BURITI –MS 

 

 Foi necessário a elaboração do mapa de uso da terra no Município estudado 

para ser integrado ao mapa de fragilidade potencial, assim é possível gerar o mapa 

de fragilidade ambiental ou emergente por técnicas de álgebra de mapas. Foram 

elaborados mapas de 3 períodos: 1998, 2008 e 2018. 

 Para elaborar o mapa de uso da terra do ano de 1998, foram adquiridas duas 

imagens LANDSAT 5, sensor TM, das órbitas ponto 225/74 e 225/75, imageadas em 

20 de outubro de 1998, bandas 3, 4 e 5. Para o ano de 2008, foram adquiridas duas 

imagens LANDSAT 5, sensor TM, das órbitas ponto 225/74 e 225/75, imageadas em 

15 de outubro de 2008, bandas 3, 4 e 5. Por fim, para o ano de 2018, uma imagem 

LANDSAT 8, da órbita ponto 225/74, bandas 4, 5, 6, e 8, datada de 09 de setembro 

de 2018. As imagens foram baixadas do site do United States Geological Survey – 

USGS. 

Foi necessário a elaboração de mosaicos das imagens LANDSAT 5 – TM, pois 

foram utilizadas duas cenas para cobrir a área de estudo. Para fazer esse 

procedimento foi utilizado o software livre e gratuito QGIS 2.18.25 (QGIS Development 

Team, 2016). 

Foi criado um projeto para cada ano em análise no software Spring 5.5.5, as 

imagens dos respectivos anos foram incorporadas nos projetos juntamente com o 

limite do Município de Dois Irmãos do Buriti, para realizar o recorte da área de 

interesse para iniciar a classificação. 

Das imagens LANDSAT 5 – TM (1998, 2008), foi realizada a composição falsa 

cor RGB, associando o R a banda 5, o G a banda 4 e o B foi associado a banda 3. Da 

imagem LANDSAT 8 – OLI (2018), foi realizada a composição falsa cor RGB, onde o 

R foi associado a banda 6, o G foi associado a banda 5 e o B foi associado a banda 
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4. Também foi realizado o tratamento da imagem com a ferramenta de contraste, para 

assim as imagens serem recortadas usando como máscara o limite do Município. 

 Após o recorte de todas as bandas da imagem LANDSAT - 8, foi realizada a 

fusão com a banda 8 para melhorar a resolução espacial da imagem. Para isso foi 

feita uma transformação das bandas 4, 5 e 6 de RGB para IHS, o próximo passo foi 

transformar de IHS para RGB novamente, mas substituindo o I (intensidade) pela 

banda 8, ao completar essa técnica de fusão a imagem passou de 30m para 15m de 

resolução espacial. 

 Para realizar a classificação, primeiramente foi necessário fazer a segmentação 

da imagem por regiões, o processo foi feito com a ferramenta de segmentação do 

Spring 5.5.4 onde é atribuído um número para similaridade e um número para Área 

(pixels), a segmentação que melhor separou as feições foi a de Similaridade 4 e Área 

6, foi utilizado os mesmos parâmetros de segmentação em todas as imagens. 

 Após a realização da segmentação, foi aberta a janela de Classificação de 

imagens, selecionada as imagens RGB fusionadas, criado um novo arquivo de 

contexto por regiões e selecionado a arquivo de segmentação. Após isso foi iniciado 

o treinamento com a aquisição de amostras das feições, por conseguinte iniciada a 

classificação por regiões utilizando o Algoritmo Batacharya. 

4.6.1 – Validação do mapeamento do Uso da terra 

 A coleta dos dados foram feitas principalmente em dois trabalhos de campo, 

em 15 de junho de 2018, para fazer o reconhecimento da área rural do município, e 

identificar as classes de uso da terra, outro campo em 10 de novembro de 2019 para 

coletar mais pontos amostrais das classes, dentre outras visitas a área rural do 

município em pontos específicos e em datas aleatórias. 

 Foi utilizada a matriz de confusão utilizando o software ENVI 5.3, foram 

adquiridos 50 pontos por classe em cada imagem classificada, a fim de verificar a 

acuraria do mapeamento das classes de uso da terra, para isso levou-se em 

consideração os intervalos determinados por Landis; Koch (1977), descrita na Tabela 

6. 
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Tabela 6 – Valores do índice Kappa. 

Valor de Kappa Qualidade da Classificação 

0,00 Péssima 

0,01 – 0,20 Ruim 

0,21 – 0,40 Razoável 

0,41 – 0,60 Boa 

0,61 – 0,80 Muito Boa 

0,81 – 1,00 Excelente 

Fonte: Landis; Koch (1977). 

 Congalton (1991) descreve os critérios para avaliar e realizar a comparação 

da exatidão dos mapeamentos temáticos, segundo o autor, uma matriz de erro pode 

ser usada como o ponto de partida para a aplicação de uma série de técnicas 

estatísticas descritivas e analíticas. Pois por meio da estatística obtemos o índice de 

exatidão global, em que se divide o total de pixels classificados corretamente (diagonal 

da matriz) pelo número total de pixels da matriz. A verificação da exatidão das 

categorias é realizada de forma similar. Deste modo, o índice Kappa é uma é muito 

utilizado para aferir tal exatidão. 

 

4.7 MAPEAMENTO DAS APPs  

  

 A delimitação das áreas de preservação permanente foi elaborada de acordo 

com a legislação vigente: Art. 3º, item II e delimitada nos termos do Art. 4° itens I, II, 

IV, V, VIII e IX da Lei nº 12.651, de 25 de maio de 2012 (BRASIL, 2012). Foi adquirido 

o shapefile com a hidrografia de Mato Grosso do Sul (SILVA et al., 2011) e aplicado o 

método de buffer no ArcGis/ArcMap. 

 É possível visualizar as APPs e sua distribuição no Município de Dois Irmãos 

do Buriti na figura 14. 
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Figura 14 – Mapa das APPs do Município de Dois Irmãos do Buriti- MS. 
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4.8 – FRAGILIDADE POTENCIAL 

 

 Para que o mapa de fragilidade potencial fosse elaborado foi necessária a 

aplicação de técnica de álgebra de mapas, onde valores para cada classe de mapas 

foram atribuídas e posteriormente ponderadas em ambiente SIG, para isso foram 

utilizados os valores referente a metodologia de Ross (1994;2012). 

 Para realizar a álgebra de mapas foi utilizada a ferramenta Weighted Overlay 

do software ArcGis/Arcmap 10.5, foram adicionadas as seguintes variáveis: Áreas 

Prioritárias, Solos, Pluviosidade e declividade. Após a ponderação das variáveis 

propostas por Ross (1994), o resultado foi convertido em formato vetorial, por meio da 

ferramenta Raster To Polygon, disponível em Conversion Tools>From Raster>Raster 

to Polygon, para assim ser realizada a sobreposição das Áreas de Preservação 

Permanente (APP) de 50m e 30m, por meio da ferramenta Update, disponível em 

Analysis Tools>Overlay>Update.  

O resultado da álgebra de mapas somado as APPs foi reconvertido para Raster 

utilizando a ferramenta Polygon to Raster, disponível em Conversion Tools>To 

Raster>Polygon to Raster, para poder ser reclassificado por meio da ferramenta 

Reclassify, disponível em Apatial Analyst Tools>Reclass>Reclassify, assim as Áreas 

de Preservação Permanente (APP) foram reclassificadas para peso 5 (Muito Alta 

Fragilidade Ambiental). 

 

4.9 – FRAGILIDADE AMBIENTAL  

 

 A fragilidade ambiental foi elaborada através da álgebra de mapas entre o uso 

da terra e a fragilidade potencial do Munícipio, tomando como referência a 

metodologia de Ross (1994; 2012). 

 Para a sobreposição ponderada ser possível, foi feita a conversão dos arquivos 

para o formato raster e também a sua reclassificação. A seguir foi utilizada a 

ferramenta Weighted Overlay, disponível no seguinte caminho: Spatial Analyst Tools 

/ Overlay / Weighted Overlay. 
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4.10 – EROSÃO DE SOLO 

 Primeiramente foi realizado o campo em pontos conhecidos no município de 

incidência de erosão de solo, efetuou-se a coleta dos pontos, visualização e anotação 

do tipo de cobertura vegetal e solo do local e por fim, coletado os pontos com um 

aparelho GNSS. 

 A seguir, iniciou-se uma pesquisa de outros pontos de erosão no limite do 

Município de Dois Irmãos do Buriti, utilizando o software Google Earth Pro. Foram 

encontrados no total 18 pontos de erosão de solo (Figura 15). Tais pontos foram 

salvos em KML, para converter os pontos para shapefile foi utilizado o software livre 

QGIS 2.18.25 (QGIS Development Team, 2016), pois assim foi possível abri-los no 

ArcGis/Arcmap 10.5 para analisar os pontos juntamente com a fragilidade ambiental 

e as suas vareáveis. A partir do Google Earth também foi possível, através da 

visualização das imagens históricas, visualizar o ano que a erosão surgiu. 
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Figura 15 – Pontos e distribuição espacial das Erosões de Solo do Município de Dois 
Irmãos do Buriti – MS. 
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5 RESULTADOS E DISCUSSÃO 

 

5.1 Mapeamento de uso da terra 

 

 Foram mapeados os usos da terra do município de Dois Irmãos do Buriti – MS 

em três datas diferentes, no anos de 1998, 2008 e 2018, para assim realizar uma 

análise de como foram as mudanças de 10 em 10 anos, totalizando assim um intervalo 

temporal de 20 anos.  

 Com o mapeamento do uso da terra do ano de 1998, foram obtidas quatro 

classes temáticas distintas, são elas: Agricultura, Pastagem, Vegetação Ciliar e 

Cerrado, tais classes foram agrupadas de modo a facilitar a posterior atribuição de 

peso na reclassificação, conforme mostra a figura 16. 

 As áreas classificadas como agricultura no município ocupam a área de 

10,38%. As áreas classificadas como pastagem abrangem uma área de 33,24%, 

ocupavam a segunda maior área, com o nível médio de fragilidade potencial. 

Ocupando uma área com 35,47%, a vegetação ciliar foi a maior área do referido ano, 

com o nível de fragilidade ambiental muito baixa. As áreas de Cerrado totalizam uma 

área de 20,91%, possui um nível de fragilidade ambiental baixa, conforme a Tabela 8. 

 Ao analisar o ano de 1998, constata-se que ao somar a área de Vegetação 

Ciliar e a área de Cerrado, obtemos o total de 56,37%, ou seja, uma área substancial 

do município, mais da metade, com a fragilidade da cobertura do solo baixa ou muito 

baixa, evidenciando uma baixa antropização para o ano em questão.  
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Figura 16: Mapa de Ocupação e Uso da terra do município de Dois Irmãos do Buriti 

– MS – 1998. 
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Tabela 7 – Uso da terra no município de Dois Irmãos do Buriti em 1998 – quantificação 

e graus de fragilidade.  

Uso da Terra e 
Cobertura Vegetal 

Área Graus de 
fragilidade 

Peso 

km² % 

Agricultura 243,11 10,38 Alto 4 
Pastagem 778,22 33,24 Médio 3 

Vegetação Ciliar 830,28 35,47 Muito Baixa 1 
Cerrado 489,43 20,91 Baixa 2 

Fonte: Adaptado de Ross (1994). 

 

 O mapeamento de uso da terra do município de ano de 2008, Figura 17, chegou 

aos seguintes resultados: Com 5,57% da área a Agricultura ocupou a menor classe. 

A área de Pastagem obteve um aumento substancial no período de 10 anos, ficando 

com uma área de 54,80% sendo a maior classe. A área de Vegetação Ciliar abrangeu 

um total de 9,61%. Tal área foi a que mais sofreu mudanças nos últimos 10 anos, 

evidenciando a ocupação dessas áreas para uso agrícola e principalmente pastagem. 

Com uma área de 30,02%, a Savana Cerrado também teve um aumento. Os dados 

de área e porcentagem das classes podem ser observados na tabela 8. 

Tabela 8 – Uso da Terra no município de  Dois Irmãos do Buriti em 2008 – 

quantificação e peso. 

Uso da Terra e 
Cobertura Vegetal 

Área Graus de 
fragilidade 

Peso 

km² % 

Agricultura 130,47 5,57 Alto 4 
Pastagem 1282,94 54,80 Médio 3 

Vegetação Ciliar 225,02 9,61 Muito Baixa 1 
Cerrado 702,60 30,02 Baixa 2 

Fonte: Adaptado de Ross (1994). 
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Figura 17 – Uso da terra de Dois Irmãos do Buriti – MS – 2008. 
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 Por fim, para completar o quadro de análise multitemporal do período de 20 

anos do município, foi realizado o mapeamento do uso da terra do ano de 2018, 

conforme observa-se na figura 24, bem como o agrupamento dos dados, por 

porcentagem e km², pode ser analisado na tabela 9. 

 A coberta de Agricultura ocupou a menor área, totalizando 3,42%, com um 

médio grau de fragilidade, é observável um decréscimo na região norte e central do 

município, porém houve um aumento na região sul, impulsionado pelo plantio da soja 

próximo ao limite entre Dois Irmãos e Sidrolândia, cabe ressaltar que a agricultura do 

município é composta basicamente por soja e milho. (Figura 18).  

Figura 18 – Classe de Agricultura em Dois Irmãos do Buriti – A e B.  

Fonte: Silva A. A. M. (2019). Trabalho de campo, ( A - Novembro, B – Janeiro). 

 

A área de Pastagem totalizou 54,32%, com um médio nível de fragilidade, é 

possível observar que em 2018 a classe teve a mesma porcentagem que no ano de 

2008 (figura 21). A cobertura de pastagem é do tipo plantada na região de cerrado, 

Brachiara decubens, pois tem um fácil manejo e adaptação, além da boa 

palatabilidade e digestibilidade pelo rebanho (AGRAER, 2019). 

 A figura 19 ilustra a pastagem em dois pontos distintos, a figura 19 (A) é de 

uma pastagem as margens da MS-162, próximo ao km 2, na sub-bacia do Rio Dois 

B A 
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Irmãos, a figura 19 (B) é de uma pastagem localizada no Assentamento Piúva V, 

situada na sub-bacia do Córrego Capim Branco. 

Figura 19 – Classe de Pastagem no município de Dois Irmãos do Buriti – MS-162, 

próximo ao km 2 (A) e Assentamento Piúva V (B).  

Fonte: Silva A. A. M. (2019). Trabalho de Campo – novembro, 2019. 

Com 16,52% a menor área foi a Vegetação Ciliar, com uma fragilidade muito 

baixa, porém apesar de ser a menor área, houve um aumento da classe quando 

comparado com os últimos 10 anos. 

Tal aumento coincide com a criação da Lei Complementar nº 05/2009, de 27 

de Janeiro de 2009, que dispõe sobre a política municipal de Meio Ambiente, que eu 

seu art. 4º, inciso I, versa sobre o incentivo à adoção de hábitos, costumes, posturas 

e práticas sociais e econômicas não prejudiciais ao meio ambiente, dentre outros 

interesses municipais. Também foi criado com essa lei, o Conselho Municipal de Meio 

Ambiente, que dentre outras funções deve estabelecer normas, padrões, critérios e 

parâmetros de qualidade ambiental, realizar o zoneamento ambiental e o 

licenciamento e revisão de atividades potencialmente poluidoras (DOIS IRMÃOS DO 

BURITI, 2009). 

A figura 20 ilustra a Vegetação Ciliar em duas localidades diferentes, a figura 

20 (A) é referente a uma vegetação ciliar localizada ao sul da área urbana do 

município, na sub-bacia do Córrego Angico, já a figura 20 (B) refere-se a um ponto no 

Assentamento Santa Amélia, na sub-bacia do Córrego Quati. 

A B 
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Figura 20 – Classe de Vegetação Ciliar no município de Dois Irmãos do Buriti – Sub-

bacia do Córrego Angico (A) e Assentamento Santa Amélia (B).  

Fonte: Silva, A. A. M. (2019). Trabalho de Campo – novembro, 2019. 

 

As áreas cobertas por Cerrado ocupam a segunda maior área, totalizando 

25,34%, com um nível baixo de fragilidade, na Figura 21 observa-se duas áreas de 

reserva legal, visitadas no trabalho de campo, no assentamento Marcos Freire, 

localizado na Bacia Hidrográfica do Rio Dois Irmãos, braço leste. Verifica-se tais 

dados do uso da terra do ano de 2018 na tabela 9. 

Figura 21 – Classe de Cerrado no município de Dois Irmãos do Buriti – MS. 

Fonte: Silva, A. A. M. (2019). Trabalho de Campo – novembro, 2019. 

 As áreas classificadas como Silvicultura ocupam uma porcentagem de 5,4%, 

com um nível baixo de fragilidade, é a segunda menor classe de uso da terra, porém 

não menos importante, pois vem crescendo nos últimos anos. A Silvicultura tem um 

destaque na região norte com o plantio de eucalipto (figura 22), onde se encontra a 
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maior fazenda, em área, do município de Dois Irmãos do Buriti, com seus 32.596,37 

ha, a Fazenda Lageado, vem substituindo áreas de pastagem por tal cultura. 

Figura 22 – Classe de Silvicultura no município de Dois Irmãos do Buriti – MS. 

 

Fonte: Silva, A. A. M. (2019). Trabalho de Campo – janeiro, 2019. 

 

Para a melhor compressão das porcentagens de uso da terra dos anos de 1998, 

2008 e 2018, foi elaborado o gráfico da figura 23, possibilitando a visualização dos 

dados de mudança do uso da terra por classes nos respectivos anos analisados. 

Figura 23 – Gráfico com as áreas de uso da terra no município de Dois Irmãos do 

Buriti – MS, nos anos de 1998, 2008 e 2018, em %. 

 

Fonte: Silva, A. A. M. (2019). 
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Tabela 09 – Uso da Terra no município de Dois Irmãos do Buriti em 2018 – 

quantificação e peso. 

Uso da Terra e 
Cobertura Vegetal 

Área Graus de fragilidade Peso 

Km² % 

Agricultura 79,97 3,42 Alto 4 
Pastagem 1271,56 54,32 Médio 3 
Vegetação Ciliar 386,77 16,52 Muito Baixa 1 
Cerrado 476,33 20,34 Baixa 2 
Silvicultura 126,41 5,40 Baixa 2 

Fonte: Adaptado de Ross (1994). 
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Figura 24 – Mapa de Uso da Terra do município de Dois Irmãos do Buriti – MS – 2018. 
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5.2 RELEVO 

 

 Verifica-se que no Município de Dois Irmãos do Buriti – MS, a altimetria varia 

da ordem de 154 m a 585 m, conforme mostrado na Figura 10. 

 No município de Dois Irmãos do Buriti, podemos observar que 63,76% da área 

apresenta declividades menores que 6%, sendo considerado de fragilidade muito 

baixa. A segunda maior classe, com 27,44% da área, foi a de declividade de 6% a 

12%, com grau de fragilidade baixa (Tabela 10). A Fragilidade média, com 6,27% ficou 

em terceiro lugar. A Fragilidade alta ficou com uma área de 1,57%, ou seja, entre 20% 

a 30%. A menor classe foi a muito baixa, com apenas 0,96%, com uma declividade 

maior que 30% (Figura 25). 

Figura 25 – Gráfico da distribuição da declividade por área do município de Dois 

Irmãos do Buriti - MS, segundo os graus de fragilidade. 

 

Fonte: Radar SRTM, organização: Silva, A. A. M (2019). 
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Tabela 10 – Quantificação das classes de declividade do município de Dois Irmãos 

do Buriti – MS. 

Classes de 
Declividade 

Área (km²) Área (%) Grau de 
Fragilidade 

>6% 1491,75 63,76 1-Muito Baixa 
De 6% a 12% 641,92 27,44 2-Baixa 

De 12% a 20% 146,59 6,27 3-Média 
De 20 % a 30% 36,79 1,57 4-Alta 

>30% 22,44 0,96 5-Muito Alta 

Fonte: Dados da pesquisa/Adaptado de Ross (1994). 

  

A partir dos dados, verifica-se que na maior parte da área do município de Dois 

Irmãos do Buriti – MS, predominam as classes muito baixa e baixa (Figura 26), as 

duas classes somam 91,20% da área do município, ou seja, a maior parte do 

município possui relevo plano, com exceção das áreas a noroeste, próximo ao limite 

com os municípios de Aquidauana e Anastácio, situadas ao norte da Bacia 

Hidrográfica do Rio Dois Irmãos, também ao sul do município, próximo ao quilômetro 

458 da BR-060 e algumas poucas áreas ao norte. 

Ao comparar tais dados, com os estudos sobre fragilidade potencial e 

emergente, realizados próximo ao município de Dois Irmãos do Buriti, observa-se que 

os dados sobre a fragilidade da declividade são similares, sendo a classe muito baixa 

a de maior destaque. Em seu estudo sobre a Bacia Hidrográfica do Córrego Pulador 

em Anastácio, Navarro (2019), ao mapear a fragilidade da declividade da mesma, 

classificou 58,2% como muito baixa, 21,03% foi classificado como baixa, a classe 

média ficou com 6,15%, a classe alta com 2,15% e a classe muito alta com 2,48%. 

Borges (2018), em seu estudo sobre a fragilidade ambiental e impactos 

erosivos na bacia hidrográfica do Rio da Prata, no Mato Grosso do Sul, também 

mapeou a fragilidade da declividade em sua área de estudo, chegando ao seguinte 

resultado: 57% foi classificada como muito baixa, 31,3% como baixa, a classe média 

com 8,5%, a alta com 2% e por fim, 1,2% foi classificado como muito alta. 
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Figura 26 – Mapa das áreas das Classes de Declividade do município de Dois Irmãos 

do Buriti – MS em %. 
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5.3 INTENSIDADE PLUVIOMÉTRICA 

 

 Os dados encontrados na Tabela 11 indicam os valores encontrados em todas 

as estações analisadas, tais dados variam de 1152mm de precipitação mínima anual, 

na estação localizada em Nioaque – MS, e a máxima de 1398mm de precipitação 

anual, na estação localizada no município de Sidrolândia – MS, localizado ao sul do 

Município de Dois Irmãos do Buriti – MS.  

 A área analisada é verifica-se que a média anual varia de 1215mm a 

1353,41mm por ano (figura 27). O período chuvoso no município dura 9 meses do ano 

(setembro a maio), possuindo 3 meses de estiagem (junho e agosto), tais dados foram 

levados em conta para a elaboração da carta de intensidade pluviométrica e posterior 

combinação dos dados para chegar na carta de fragilidade potencial.  

 

Tabela 11 – Distribuição espacial das estações pluviométricas. 

Município Estação Localização Média 
anual 
(mm) 

Nioaque Nioaque 
(Altitude 193) 

55°49'30,309"W, 21°9'20,693"S 1152 

Maracaju Maracaju 
(Altitude 360) 

55°8'10,204"W, 21°37'3,731"S 1395 

Bonito Bonito (Altitude 
390) 

56°30'58,611"W, 21°6'54,148"S 1380 

Jardim Jardim (Altitude 
292) 

56°5'6,21"W, 21°27'2,822"S 1287 

Anastácio Estrada MS-345 
(Altitude 145) 

56°5'21,364"W, 20°45'44,505"S 1186 

Dois Irmãos do 
Buriti 

Faz. Lageado 
(Altitude 204) 

55°26'40,993"W, 20°17'27,818"S 1215 

Sidrolândia Sidrolândia 
(Altitude 456) 

54°58'53,598"W, 20°57'49,695"S 1398 

Campo Grande Vau do Balsamo 
(Altitude 403) 

54°30'28,555"W, 20°59'36,138"S 1379 

Sidrolândia Capão Bonito 
(Altitude 408) 

54°45'52,905"W, 21°10'34,088"S 1293 

Fonte: ANA, 2018. 
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Figura 27 – Precipitação média anual do município de Dois Irmãos do Buriti – MS. 
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5.4 FRAGILIDADE POTENCIAL 

 

 O mapa de fragilidade potencial foi obtido por meio de técnicas de álgebra de 

mapas incluindo as variáveis: solos, declividade, intensidade pluviométrica e áreas 

prioritárias para a conservação da biodiversidade (Figura 28).  

 As áreas foram agrupadas em 5 classes de fragilidade (Tabela 12), conforme a 

metodologia proposta por Ross (1994), foram elas: muito baixa (34,05%), baixa 

(34,74%), média (20,44%), Alta (6,42%) e Muito Alta (4,35%). 

Tabela 12 – Áreas correspondentes a Fragilidade Potencial do município de Dois 

Irmãos do Buriti – MS. 

Classes de Fragilidade Potencial Área (km²) Área (%) 

1 – Muito Baixa 796,65 34,05 
2 – Baixa 812,68 34,74 
3 – Média 477,98 20,44 
4 – Alta 150,16 6,42 

5 – Muito Alta 101,87 4,35 

Fonte: Dados de pesquisa. 

 

Nota-se que o maior nível de fragilidade encontrado na área é a de nível baixo, 

com 34,74%; seguido do nível muito baixo, com 34,05%; o terceiro maior nível de 

fragilidade potencial foi a média, com 20,44% da área do município. Sendo assim, 

essa três classes somadas equivalem a um total de 89,23% da área do município, ou 

seja, levando em consideração a soma de todos os fatores analisados segundo a 

metodologia de Ross (1994;2012) para gerar a carta de fragilidade potencial, verifica-

se que a maior parte de Dois Irmãos do Buriti não possui um elevado nível de 

fragilidade potencial. Esse resultado, se explica, pelo solo encontrado na área, 

Latossolo Vermelho, cuja fragilidade é muito baixa e não possuir declividades muito 

acentuadas, entre 0 e 6%. 
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Figura 28 – Mapa de Fragilidade Potencial do município de Dois Irmãos do Buriti – 

MS.
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 Nesta perspectiva, Peixoto et al. (2018), ao mapear a fragilidade potencial do 

município de Ivinhema – MS, também não encontrou grandes graus de fragilidade, 

classificando o maior grau de fragilidade no grau Baixa, 62%, seguido da fragilidade 

muito baixa, com 29%, 8% com fragilidade média e 1% fragilidade alta.  

 Pires, Mendonça e Bacani (2015) em seu estudo sobre o município de 

Aquidauana, encontrou valores diferentes, no que se refere a fragilidade potencial, 

sendo notável em seu trabalho a grande porcentagem da fragilidade alta, ou seja, 

78,72% da área do município. A grande extensão da área classificada como de 

fragilidade alta se deve ao fato de nesse região está localizada a Planície do Pantanal 

Sul-Mato-Grossense, sendo influenciada pelas características do solo e das áreas 

prioritárias (Alta e extremamente alta). 

 Ao analisar o mapa de fragilidade potencial, observa-se que as áreas 

classificadas como de alta fragilidade, somando uma área de 6,42%, fazem referência 

às áreas classificadas como extremamente altas para a conservação da 

biodiversidade (BRASIL, 2007). As áreas correspondentes são: Ao norte a Serra de 

Maracaju, a sudeste uma região de beleza paisagística onde se considera o fomento 

ao ecoturismo, por fim, a sudoeste onde se situa um corredor da Serra de Maracaju, 

área de muitas nascentes e segundo o MMA (2007), há estudos sobre a criação de 

um Parque Nacional. É possível observar essas informações na figura 29. 

 Porém, outros fatores contribuíram para a classificação, como a alta fragilidade 

do solo nas mesmas regiões e a declividade acentuada. 

 As áreas classificadas como sendo de Muito Alta Fragilidade Potencial, 4,35% 

da área mapeada, basicamente correspondem às Áreas de Proteção Permanente. 

 

 

 

 

 



75 
 

Figura 29 – Equivalência das Classes de Fragilidade Potencial e Áreas Prioritárias 

no município de Dois Irmãos do Buriti – MS.
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5.5 FRAGILIDADE AMBIENTAL (EMERGENTE) 

 

 A análise da Fragilidade Ambiental (ou emergente) do Município de Dois Irmãos 

do Buriti foi realizada para os anos de 1998, 2008 e 2018, tendo assim um espaço 

temporal de 20 anos.  

 No ano de 1998 (Figura 30) observa-se que o grau de Fragilidade Ambiental 

Baixa ocupa a maior área do município, com uma área de 1130,55 km² 

correspondendo a 48,30% (Tabela 13).  

 Com uma área de 821,13km² o que equivale a 35,08%, o grau de fragilidade 

média ocupou a segunda maior área do município. Tal grau de fragilidade se localiza 

em áreas com maiores variações de relevo, entre baixa e média, possuindo as classes 

de solo: Neossolos Litólicos, Neossolos Quartzarênicos e Gleissolo Háplico, todos 

com fragilidade alta, porém a fragilidade ambiental não foi alta ou muito alta por causa 

da cobertura vegetal e uso da terra no ano de 1998, tais áreas eram cobertas, em sua 

maioria por Cerrado. 

 A Fragilidade Muito Baixa ocupa uma área de 207,45 km², equivalente a 8,86%, 

ocupadas por Cerrado ou Vegetação Ciliar, solos com baixa fragilidade e relevos 

planos.  

Com 4,40% correspondendo a uma área de 103,14km², a fragilidade Muito Alta 

foi atribuída as APPs.  

Por fim, com 3,36% e uma área de 78,58km² ficou a classe de Fragilidade Alta, 

associados a solos com alto grau de fragilidade, relevo acima de 30% e cobertura uso 

predominantemente por agricultura. 

 

Tabela 13 – Áreas correspondentes a Fragilidade Ambiental do município de Dois 

Irmãos do Buriti – MS, em 1998. 

Classes de Fragilidade Ambiental Área (km²) Área (%) 

1 – Muito Baixa 207,45 8,86 
2 – Baixa 1130,55 48,30 
3 – Média 821,13 35,08 
4 – Alta 78,58 3,36 

5 – Muito Alta 103,14 4,40 

Fonte: Dados da Pesquisa 
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Figura 30 – Mapa de Fragilidade Ambiental do município de Dois Irmãos do Buriti – 

MS – 1998. 
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 Analisando a Fragilidade Ambiental do ano de 2008, foram obtidas as mesmas 

5 classes de fragilidade (Figura 32), assim, a maior classe de fragilidade foi a de 

Fragilidade Média, com uma área de 1069,46 km² que equivale a 45,70% (Tabela 14). 

Ao compararmos com o a fragilidade de 1998, nota-se um aumento na classe de 

fragilidade média (Figura 31), isso se explica pelo aumento da uso do terra para 

pastagens, fato esse já citado no item 5.1.  

Figura 31 – Gráfico da Fragilidade Ambiental do município de Dois irmãos do Buriti – 

MS, dos anos 1998 e 2008. 

 

Fonte: Silva, A. A. M. (2019). 

 A segunda maior classe foi a de Fragilidade Baixa, com uma área de 1055 km², 

ou 45,08% do município. Sua diminuição em relação ao ano de 1998 se dá pelo 

mesmo motivo, o aumento de áreas destinadas à pastagem e a retirada de vegetação 

nativa. 

 A Classe de Fragilidade Ambiental Muito Alta, associada às APPs, ficou com 

103,03 km² correspondendo a 4,40%. Tais áreas não sofrearam alteração, pois levam 

em conta a Lei nº 12.651, de 25 de maio de 2012 (BRASIL, 2012) que prevê 

destinação das áreas de proteção permanentes. 

 Com 3,02% e uma área de 70,79 km², foi destinada como área de Fragilidade 

Alta. Por fim, com 1,8% ou 42,21km² ficou a classe Muito Baixa, classe essa que teve 
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uma queda muito grande em área com relação ao ano de 1998. Tal diminuição está 

associada à diminuição da mata nativa para uso agrícola do solo (Figura 17). 

 

Tabela 14 – Áreas correspondentes a Fragilidade Ambiental em 2008. 

Classes de Fragilidade Ambiental Área (km²) Área (%) 

 1 – Muito Baixa  42,21 1,80 
2 – Baixa 1055,24 45,08 
3 – Média 1069,46 45,70 
4 – Alta 70,79 3,02 

5 – Muito Alta 103,03 4,40 

Fonte: Dados da Pesquisa. 
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Figura 32 – Mapa de Fragilidade Ambiental do município de Dois Irmãos do Buriti – 

MS – 2008. 
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 Por meio da análise do Mapa de Fragilidade Ambiental do ano de 2018 (Figura 

33), constata-se que a área de fragilidade considerada baixa, ocupando uma área de 

1101,34 km² e 47,09%, foi a maior classe (Tabela 15), obtendo um crescimento de 

dois pontos percentuais quando comparado com 2008. 

 A segunda maior classe foi a de Fragilidade Ambiental Média, com 993,87 km² 

e 42,49% da área do município, tal classe obteve um pequeno declínio quando 

comprado ao ano de 2008, com 3 pontos percentuais. 

 A classe considerada de Fragilidade Muito Alta, que está associada às APPs, 

praticamente manteve os mesmos números nas três datas analisadas, em 2018 ficou 

com 4,35% da área do município, o que equivale a 101,83 km². 

 A classe de Fragilidade Muito Baixa aumentou nos últimos 10 anos, passou de 

1,8% em 2008 para 3,69% em 2018. A classe Alta ocupou uma área de 2,38%, 

55,61km², sendo a menor classe do ano analisado. 

 Ao vermos os dados da Tabela 15, verificamos que 93,27% do município tem 

um nível de fragilidade ambiental de muito baixa a média, no ano de 2018. E que 

apenas 6,73% é considerado como de fragilidade entre alta e muito alta. Entre as 

variáveis destaca-se para esse resultado o relevo, 63,76% do município com 

declividade entre 0 e 6%, o solo, em sua maioria de baixa fragilidade e a cobertura 

vegetal, em sua maioria pastagem, que embora seja uma cobertura antrópica não 

possui uma fragilidade elevada. 

 

 

Tabela 15 – Áreas correspondentes a Fragilidade Ambiental em 2018. 

Classes de Fragilidade Ambiental Área (km²) Área (%) 

 1 – Muito Baixa  86,36 3,69 
2 – Baixa 1101,34 47,09 
3 – Média 993,87 42,49 
4 – Alta 55,61 2,38 

5 – Muito Alta 101,83 4,35 

Fonte: Dados da Pesquisa. 
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Figura 33 – Mapa de Fragilidade Ambiental do município de Dois Irmãos do Buriti – 

MS – 2018. 
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 Na Figura 34 verifica-se a variação dos valores em porcentagem das classes 

de fragilidade ambiental do município de Dois Irmãos do Buriti – MS, dos anos de 

1998, 2008 e 2018. 

 Analisando os dados dos três anos, nota-se que a fragilidade ambiental muito 

baixa apresentou uma variação no período de 20 anos, no ano de 1998 representava 

8,86% da área, diminuiu no ano de 2008 representando 1,8% da área de estudo, em 

2018 aumentou para 3,69%. Tal fato, ocorreu devido a retirada da vegetação natural 

para uso antrópico, os dados podem ser associados com a redução de vegetação 

ciliar dos anos analisados. 

 A classe de fragilidade classificada como baixa também sofreu variações, 

representava 48,30% em 1998, caiu para 45,08% em 2008 e subiu no ano de 2018 

para 47,09%. Também, influenciado pela troca de vegetação natural, para uso 

antrópico, associado as mudanças econômicas ocorridas no município nos últimos 20 

anos, quando o município fez uma transição para a criação de bovinos, aumentando 

por assim, o plantio de pastagens.  

A classe de fragilidade ambiental média em 1998 representava uma área 

equivalente a 35,08%, aumentou consideravelmente em 2008 para 45,69% e regrediu 

para 42,49% no ano de 2018. Tal acontecimento, se deu, pois, houve um aumento 

significativo na pastagem nos últimos anos, aumentando de 33,24% em 1998 para 

54,79% em 2018. O uso da terra como pastagem para criação de gado foi incentivada 

pela inauguração do frigorífico no município em 2010 e da organização da Cooperativa 

de Produtores de Leite – COOPERDIB (ACRISUL, 2018). 

 As áreas classificadas como sendo de alta fragilidade ambiental e a muito alta 

não variaram muito durante as três datas analisadas. A Alta representava um total de 

3,36% em 1998, foi para 3,02% no ano de 2008 e para 2,38% em 2018. A classe 

considerada de Muito Alta fragilidade ficou praticamente restrita as APPs variando 

entre 4,41% no ano de 1998, 4,40% no ano de 2018 e 4,35% no ano de 2018. 

 A redução da classe de alta fragilidade se deve ao fato de uma pequena 

recuperação da Mata Ciliar, nos últimos 10 anos e a substituição da agricultura 

temporária em áreas de fragilidade potencial alta, por pastagem. Essas melhorias, 

também coincidem com a criação da Lei Complementar nº 05/2009, de 27 de Janeiro 

de 2009, que dispões sobre a Política Municipal de Meio Ambiente, que em seu art. 
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4º, inciso I, versa sobre o incentivo à adoção de hábitos, costumes, posturas e práticas 

sociais e econômicas não prejudiciais ao meio ambiente, dentre outros interesses 

municipais. Também foi criado, com essa lei, o Conselho Municipal de Meio Ambiente, 

que dentre outras funções deve estabelecer normas, padrões, critérios e parâmetros 

de qualidade ambiental, realizar o zoneamento ambiental e o licenciamento e revisão 

de atividades potencialmente poluidoras (DOIS IRMÃOS DO BURITI, 2009). 

 Para fins de comparação e análise dos resultados, é importante citar outros 

trabalhos com a temática abordando fragilidade ambiental no Estado de Mato Grosso 

do Sul. Em sua dissertação de mestrado, Borges (2018), analisou a fragilidade 

ambiental e impactos erosivos na Bacia Hidrográfica do rio da Prata, Mato Grosso do 

Sul. Em seus resultados, constata-se que sua área de estudo também não possui 

grandes níveis de fragilidade, sendo predominante a fragilidade ambiental média, com 

63,08% no último ano mapeado. 

 Navarro (2019), Diagnosticou a fragilidade ambiental como subsídio para o 

planejamento ambiental da Bacia Hidrográfica do Córrego Pulador em Anastácio – 

MS. Utilizando a metodologia de Ross (1994), analisou a área de estudo em três datas 

distintas, 1984, 2000 e 2017. A classe com maior destaque também foi a média, 

abrangendo 68,02% da área da bacia no ano de 2017. 

 Em sua dissertação de mestrado pela Universidade Federal da Grande 

Dourados, Gonçalves (2010) propôs procedimentos metodológicos para a 

determinação da fragilidade ambiental de bacias hidrográficas. Foi proposto nesse 

trabalho o mapeamento da fragilidade potencial e ambiental da Bacia Hidrográfica do 

Rio Dourados – MS, utilizando uma adaptação da metodologia proposta por Ross 

(1994). A maior classe de fragilidade ambiental, no estudo em questão, foi a baixa, 

ocupando 67,7% da Bacia analisada. 

 Desta forma, os resultados do estudo da fragilidade ambiental no município de 

Dois irmãos do Buriti- MS, corrobora e agrega aos outros estudos realizados no Mato 

Grosso do Sul, pois, assim como os estudos citados, a maior porcentagem da área de 

estudo está classificada com fragilidade baixa e média. Tendo também como fator 

predominante o uso da terra como pastagem e declividades pouco acentuadas. 
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Figura 34 – Gráfico de Fragilidade Ambiental do município de Dois Irmãos do Buriti – 

MS, dos anos de 1998, 2008 e 2018 e Comparação das Classes. 

 

 Fonte: Silva, A. A. M. (2019). 

 

5.5.1 – Análise da Fragilidade Ambiental e Erosão de Solo. 

 

 Com os pontos convertidos de KML (formato do Google Earth) para shapefile, 

foi possível fazer a sobreposição dos mesmos sobre os mapas de fragilidade 

ambiental, e suas variáveis, para assim, analisar a dinâmica que pode ter lavado ao 

processo erosivo. Todos os pontos sobrepostos ao mapa de uso da terra pode ser 

observado na figura 35. 
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Figura 35 – Distribuição dos Pontos de Erosão e Uso da Terra no município de Dois 

Irmãos do Buriti – MS. 
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Tabela 16 – Localização dos pontos de erosão de solo. 

Ponto Localização 

P1 20°39'38.60"S, 55°12'59.52"O 
P2 20°37'23.05"S, 55°15'2.02"O 
P3  20°36'29.13"S, 55°13'28.77"O 
P4 20°36'38.53"S, 55°13'51.28"O 
P5 20°36'53.20"S, 55°14'20.95"O 
P6 20°36'47.90"S, 55°14'27.16"O 
P7 20°37'6.24"S, 55°14'46.36"O 
P8 20°36'52.77"S, 55°15'7.58"O 
P9 20°35'51.35"S, 55°12'48.35"O 
P10 20°36'4.67"S, 55°21'1.44"O 
P11 20°35'41.80"S, 55°27'50.60"O 
P12 20°35'4.78"S, 55°13'19.90"O 
P13 20°35'2.44"S, 55°13'32.81"O 
P14 20°35'14.44"S, 55°26'43.98"O 
P15 20°39'23.87"S, 55°18'42.79"O 
P16 20°39'37.05"S, 55°18'37.08"O 
P17 20°35'14.97"S, 55°20'50.34"O 
P18 20°33'50.94"S, 55°30'30.62"O 

Fonte: Silva, A. A. S. (2019) 
 

As erosões 15, 16 e 17 encontram-se no assentamento Santa Amélia, sendo 

que, o 15 e 16 começaram em açudes, construídos como áreas de empréstimo para 

a pavimentação da MS-162, em locais de pastagem, com latossolo vermelho e 

declividade média. As três erosões citadas estão localizadas na sub-bacia do Córrego 

Quati que é tributário do Rio Dois Irmãos. 

Nota-se que 10 dos 18 pontos (Figura 39), estão concentrados em uma 

pequena região a leste do município, próximo ao Córrego Capim Branco. Tal 

localidade, onde os pontos se concentram, não possui uma declividade muito 

acentuada, possui Latossolo e/ou Argisolo o uso da terra é por pastagem plantada. 

Outro fato que chama a atenção é que possui uma fragilidade ambiental média ou 

baixa (Figura 40). Sendo assim, um possibilidade para ocorrer a erosão de solo nessa 

localidade é a falta de manejo do solo adequada. Ao observar as imagens históricas 

do Google, nota-se que tais erosões estão presentes há mais de 10 anos. No campo, 

percebe-se também que em muitos pontos os produtores rurais não utilizam técnicas 

de conservação do solo e dos recursos d’água. 
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 Na figura 36 verifica-se a localização das erosões 5, 6, e, 7, que estão na 

mesma propriedade, próximo ao Córrego Capim Branco. 

Figura 36 – Pontos de Erosão 5, 6, e, 7 do município de Dois Irmãos do Buriti – MS 

 

Fonte: Imagem Google Earth. 

 

Na figura 37 (A) constata-se a extensão e profundidade de erosão de solo na 

região leste do município de Dois Irmãos do Buriti - MS. Ao verificar o local da erosão, 

comparando com a classe de solo obtida pelo Macrozoneamento Geoambiental 

(1989), nota-se que há outra classe de solo no local, trata-se do Argissolo, que por 

sua vez é mais suscetível à erosão, Ross (1994,2012) atribui o peso 3 a tal classe de 

solo, ou seja, tem um grau médio de fragilidade, diferente do Latossolo, que possui 

um grau de fragilidade muito baixa. 

 Na erosão 5 (figura 37 – B) observar-se que o local da erosão tem o livre acesso 

para o rebanho bovino, isso mostra o desconhecimento, por parte dos proprietários, 

de práticas de conservação e manejo do solo. 
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Figura 37 – Trabalho de Campo, Erosão 5. 

 

Fonte: Silva, A. A. M. (2019). Trabalho de Campo – Janeiro, 2019. 

 

 A figura 38 (A) mostra a erosão 6, tal erosão se contra na mesma propriedade, 

é interessante observar a diferença dos solos entre a erosão 5 e 6, muito próximas 

uma da outra, apenas 160 m. Existem dois tipos de solos na mesma propriedade, 

latossolo vermelho, na erosão 6 e 7, e argissolo vermelho-amerelo. Porém o início do 

processo erosivo pode ter sido o mesmo, o pisoteio do gado abriu um caminho 

preferencial para as águas, dando ignição ao processo. A 650 metros a oeste da 

erosão 5, está a erosão 7, ilustrada na figura 38 – B, foi observado nessa erosão que 

o rebanho bovino a usa como caminho para chegar ao Córrego Capim Branco, para 

dessedentação.  

Figura 38 – Trabalho de Campo, Erosão 6 e 7 

 

Fonte: Silva, A. A. M. (2019). Trabalho de Campo – Janeiro, 2019. 
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Figura 39 – Relação da Fragilidade Potencial e erosão de solo do município de Dois 

Irmãos do Buriti – MS. 
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Figura 40 – Relação da Fragilidade Ambiental e erosão de solo do município de Dois 

Irmãos do Buriti – MS. 
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5.6 - Validação do Mapeamento de Uso de Terra e Cobertura Vegetal 

  

 Os mapas de uso da terra do município de Dois irmãos do Buriti- MS, dos anos 

de 1998, 2008 e 2018 passaram por um processo de validação estatística, para isso 

foi utilizado o Índice Kappa. O mapa de 1998 obteve um valor de 0.99 de concordância 

e uma acurácia global de 95,13%. No ano de 2008, foi obtido um resultado de 0,91 do 

coefiente Kappa e uma acurácia global de 99,93%. E no ano de 2018, o índice Kappa 

foi de 0.99 e uma acurácia global de 99,98%, sendo assim, os mapas foram avaliados 

como excelentes. 

 A tabela 17, apresenta a acurácia de produtor (A.P) que se refere a 

probabilidade de um pixel de referência ter sido corretamente classificado. Também 

será mostrado a acurácia de usuário (A.U) que indica a probabilidade que um pixel 

classificado na imagem representar corretamente e mesma categoria no campo 

(CATTANI et. al., 2013). 

Tabela 17 – Avaliação da precisão da classificação do uso da terra. 

Ano 1998 2008 2018 

Classes A.P (%) A.U (%) A. P 

(%) 

A. U (%) A. P 

(%) 

A.U (%) 

Agricultura 99,74 99,84 89,21 76.17 99,96 100 

Pastagem 99,98 100 96,35 99,47 100 99,97 

Mata Ciliar 99,76 99,77 81,92 42,09 100 100 

Savana Cerrado 99.99 99.95 95,41 9863 100 100 

Índice Kappa 0.9993 0.9134 0.9998 

Acurácia Global 99.9562% 95.1339% 99.9888% 
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6. CONSIDERAÇÕES FINAIS E RECOMENDAÇÕES 

 

 Conclui-se que, considerando apenas variáveis do meio físico-natural, o 

Município de Dois Irmãos do Buriti – MS tem uma fragilidade potencial predominante 

entre muito baixa e média, totalizando 89,23% de seu território. A fragilidade ambiental 

muito baixa foi a maior classe mapeada com 34,74% da área, situada em uma região 

com relevo plano, (declividades entre 0 e 6%), são as áreas mais utilizadas para a 

pecuária e plantio de eucalipto, o que reflete diretamente na fragilidade ambiental.  

 Quanto à análise da fragilidade ambiental dos anos de 1998, 2008 e 2018, 

notou-se uma variação entre as classes que evidenciam uma antropização do uso da 

terra nos últimos 20 anos, principalmente pelo plantio de pasto para a criação de 

bovinos, a agricultura sendo introduzida de maneira mecanizada no sul do município, 

com o plantio da soja, próximo ao limite com Sidrolândia – MS, próximo a BR-060. 

 Apesar do município se manter com mais de 50% de classes de fragilidade 

baixa e muito baixa no ano de 2018, e somado com a média chega-se ao total de 

93,27%, se comparado ao ano de 1998, houve uma queda das classes de fragilidade 

muito baixa e baixa. 

 O município não tem altos níveis de fragilidade ambiental alta e muito alta, por 

causa do seu solo, em sua maioria Latossolos, baixas declividades e o uso da terra 

em sua maioria com pastagem, com fragilidade média entre outros usos, com menor 

fragilidade como o eucalipto. 

 Ao analisar as erosões de solo encontradas no município e conclui-se que as 

causas são o manejo inadequado do solo e dos recursos hídricos, pois salvo algumas 

exceções, a maioria das erosões se davam em áreas que não tinham um relevo muito 

inclinado e com uma fragilidade de solo e de cobertura vegetal baixa. Tais erosões, 

causam um prejuízo muito grande, tanto econômico como ao meio ambiente.  

Desta perspectiva, para prevenir e mitigar a erosão do solo, é interessante que 

o poder público invista em técnicas disponíveis e comprovadas, junto aos agricultores, 

para o manejo e conservação do mesmo (BERTONI; LOMBARDI NETO, 1990). Pode-

se pontuar como técnicas recomendadas:  

 Cursos de práticas de manejo do solo; 
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 Ações e subsídios para o terraceamento de propriedades rurais, para 

evitar dardas excessivas de solo por meio do escoamento superficial; 

 Cercar áreas erodidas, para isola-la e evitar o pisoteio dos bovinos; 

 Preparo do solo para plantio em nível; 

 Distribuição adequada dos caminhos. 

 Sendo o município de Dois Irmãos do Buriti – MS um município localizado na 

região central do Estado de Mato Grosso do Sul, próximo a capital, assume um papel 

de importância estratégica no estado, tanto na criação de gado, que é uma atividade 

econômica importante para o município, e do plantio de soja e eucalipto. Sendo assim, 

recomendo o que sejam levados em consideração os fatores de solo, relevo, cobertura 

vegetal, recursos hídricos, entre outros, para o planejamento e uso estratégico de 

políticas públicas. 

 Os assentamentos do município também possuem um papel importante na 

dinâmica do município, que se torna ainda mais plural por conta das aldeias 

localizadas em seu limite político administrativo. Tais assentamentos, devem ser 

observados e lavados em conta no planejamento territorial do município e nos planos 

de desenvolvimento, pois é a agricultura familiar é de suma importância para a 

alimentação do brasileiro. 

Outro setor que tem muito potencial e carece de investimentos e atenção é o 

turismo, visto o grande potencial que o município tem, principalmente o ecoturismo na 

região de Palmeiras, pois tem uma beleza cênica de alto nível e pode gerar renda para 

a população e para o município e atrair investimentos. Para tal, seria interessante a 

reforma e reativação do Balneário Municipal que se localiza em Palmeira, nas 

margens do Rio Aquidauana. 

 Desse modo, um município com uma dinâmica tão rural, belezas paisagísticas 

e diverso, deve levar em conta os dados de fragilidades potenciais e ambientais para 

o planejamento e manejo do solo, pois assim, é possível produzir sem prejuízo ao 

meio ambiente. 

 Recomenda-se aos gestores uma atenção especial para as áreas prioritárias 

para a conservação da biodiversidade, áreas que podem ser destinadas a criação de 

UC, como a Serra de Maracaju ao norte, e outra área localizada a sudoeste do 

município que serve de corredor para a Serra de Maracaju e área de recarga de 
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Aquíferos, tais áreas são estratégicas tanto para o fomento ao turismo, como para a 

manutenção da biodiversidade do cerrado. 

 O mapeamento de Fragilidade Potencial e Ambiental foi de grande importância 

para a compreensão da dinâmica da área em análise, pois com os graus de 

fragilidades estabelecidos é possível um planejamento por parte dos gestores de 

forma estratégica. Analisou-se uma grande área de interesse, ou seja, toda área do 

município, utilizando as geotecnologias e com economia de tempo e recursos. Por fim, 

a pesquisa pode ser usada como subsídio para o planejamento territorial e pode ser 

o ponto de partida para o avanço do conhecimento da região e outras pesquisas. 
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